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iZotope RX 4
RX 4 is designed to be the complete toolbox for cleaning and repairing audio.
RX 4 is ideal for audio restoration and archiving, recording and mastering,
broadcasting and podcasting, sample library creation, video production,
forensics, and any application that demands spotless audio.

iZotope RX 4 is the result of years of audio signal processing research and
features the most advanced spectrogram available, as well as convenient
workflow and selection features designed to make the process of audio
restoration easier, and your results better.

We hope you enjoy using RX 4! We think it will not only breathe new life into
your noisy and damaged recordings, but also make the process of restoring
audio easier, and yes, even enjoyable!

32- or 64-bit?

RX 4 is available as a 32- and 64-bit application and suite of plug-ins.  The
quality of processing in both is the same, but 64-bit applications can access a
higher range of memory than 32-bit applications.  If your computer has more
than 4 GB of RAM, it is recommended that you use the 64-bit application. If you
have a 32-bit computer, only the 32-bit version of RX is installed.



You can run RX in 32-bit mode if you need to use 32-bit VST, or AU plug-ins, or
if you have a 32-bit operating system.

In Windows, select the iZotope RX (32-bit) or iZotope RX (64-bit) shortcut from
the Start Menu. By default, 64-bit systems only add the 64-bit version of iZotope
RX to the Start Menu.

In OS X, select iZotope RX in the Applications folder, right click it, and select
Get Info.  You can use this menu to configure which mode RX runs in.

iZotope RX 4 Advanced
Note: This help guide is shared by both RX 4 and RX 4 Advanced. When a
feature or control is exclusive to RX 4 Advanced it will be noted in the

documentation using the following symbol:

In addition to the standard version of RX 4, an extended application, iZotope RX
4 Advanced, offers even more precise control over RX 4 algorithms as well as
including iZotope's critically acclaimed 64-bit SRC sample rate conversion and
MBIT+ dither for professionals who want finer control over processing and
delivery.

RX 4 Advanced Exclusives:
n Loudness— adjustment to set the true peak and loudness of your clips
n Leveler to create clip gain envelopes in your project
n Ambience Match and EQMatch to give clips recorded differently the
same acoustic feel

n Dereverb reverberation control processor
n Declipper Threshold unlinking— independent threshold control for
repairing unbalanced, asymmetric waveforms

n Advanced Declick— tuning parameters to tackle problem clicks,
thumps, and bumps



n Adaptive noise reduction and Advanced Denoiser settings with finer
control over the noise reduction process

n Deconstruct— independent gain control of tonal and noisy audio com-
ponents

n iZotope Radius—world-class time stretching and pitch shifting
n Pitch Contour— variable resampling pitch remapper 
n Azimuth adjustment for automatic and manual alignment of audio recor-
ded to tape

n Center extraction for recovery of mid or side channel information
n History export to keep track of your projects



Authorization
Launching the Authorization Wizard
The first time you open RX, the Authorization Wizard will appear. You can
choose to either authorize RX or use it in Trial mode for evaluation purposes.
Please use your supplied RX serial number to fully authorize your product.

Trial and Demo Mode
For the first 10 days after installation, RX will run in Trial mode, which offers full
functionality with the exception of saving and batch processing. After 10 days,
RX will revert to Demo mode. In Demo mode, RX is limited to 30 seconds of
continuous playback.

iLok Support
RX supports iLok authorization. Our plug-ins will be able to detect iLok keys and
assets if you already use iLok and PACE software on your system. If you don't
already have PACE or iLok, we will not install any PACE or iLok software to
your system, and iLok authorizations will be unavailable.

Help
We have created an online article to help with common questions about our
authorization system.

Customer Support
How to purchase the full version of RX
If you are using the demo version of RX and would like the full version, you can
purchase RX or RX Advanced directly from the iZotope online store.

http://www.izotope.com/rx

Once your purchase is complete you will be sent an email confirmation and a
full version serial number that can be used to fully authorize your current
installation of RX.

https://www.izotope.com/en/support/authorization/
http://www.izotope.com/rx


iZotope Customer Support Policy
iZotope is happy to provide professional technical support to all registered users
absolutely free of charge. We also offer valuable pre-sales technical support to
customers who may be interested in purchasing an iZotope product. Before
contacting iZotope support, you can search our Product Knowledgebase to see
if the solution to your problem has already been published.

How to contact iZotope for Technical Support
For additional help with RX, please check out the support pages on our web site
at http://www.izotope.com/support or contact our customer support department
at support@izotope.com.

iZotope's highly trained support team is committed to responding to all requests
within one (1) business day and frequently respond faster. Please try to explain
your problem with as much detail and clarity as possible. This will ensure our
ability to solve your problem accurately, the first time around. Please include all
system specs and the build/version of RX that you are using.

Once your support request is submitted, you should automatically receive a
confirmation email from iZotope support. If you do not receive this email within a
few minutes please check your spam folder and make sure our responses are
not getting blocked. To prevent this from happening please add
support@izotope.com to your list of allowed email addresses.

Thank you for using RX!

http://www.izotope.com/support/
mailto:support@izotope.com?subject=RX%203%20Support
mailto:support@izotope.com?subject=RX%203%20Support


Working Inside RX

Overview
Design Philosophy
RX is a visual selection-based audio environment. Most of its user interface is
devoted to the Spectrogram/Waveform display, an integral part of the RX
workflow. The spectrogram/waveform display has many features that enable
you to refine and visualize your audio, allowing for better recognition and
selection of problematic areas of audio, ultimately providing a higher quality,
more transparent result.

Each of RX's modules provide all of the tools necessary to clean up and
enhance your audio, many of which go beyond the realm of simple restoration
tasks, allowing for Plug-in hosting, Equalization, Phase and Timing alignment
and many more.

Each module provides the same set of standard controls which allow for
different ways of applying or previewing the signal processing of that module to
your audio selection.



Standard RX module controls let you preview changes in realtime,
compare settings for analysis, and process when you’re ready

After processing your audio selection with RX's modules, you can save and
export your audio, or make use of RX's Batch Processor in order to organize
and save your files.

RX also features iZotope's 64-bit SRC and MBIT+ dithering modules to further
prepare your files, enabling you to deliver the highest audio quality possible.

Interface
Here is a general overview of RX's main workspace. It's a good idea to
familiarize yourself with this window before moving on. RX's interface is
designed to give you a full range of tools for repairing audio. In addition to its
processing modules, RX provides a range of tools for selecting, isolating and
viewing audio and an environment that will help you get the best results easily.

1. File Tabs
2. Waveform Overview
3. Help and Settings



4. Spectrogram/Waveform display
5. Playhead with Seek handle
6. Brush Cursor
7. Time Selection
8. Freeform (Brush) Selection
9. Amplitude, Frequency, and Spectrogram Color Map Scales
10. Time Format Ruler menu
11. Spectrogram/Waveform Transparency Balance slider
12. Zoom Tools and Selection Tools
13. Zoom Sliders
14. Transport and Current Time display
15. Selection and View Ranges
16. Module List
17. Undo History

File Opening & Playback
Opening Audio Files

There are many ways to open a file in RX:

1. From the File menu, selectOpen... and select the files you want to open.
2. Drag and drop a file from your operating system into the RX UI.
3. Drag a file from Finder/Explorer to the RX icon in the Dock/Desktop.
4. Double-click in the empty space of RX display.

RX supports having up to 16 files open at once.

To create a new empty file in RX, open the File menu and select New... After
you select this, you will be prompted for the sample rate and channel count of
the file you would like to create.

If you have existing audio data in your clipboard (for example, if you have
copied a selection from an existing file in RX), you can open the File menu and
choose New from Clipboard. A new file will be created with the correct sample
rate and channel count.



To navigate between files currently open in RX, either click on the file’s tab at
the top of the RX UI, or use the Control-Tab and Control-Shift-Tab keyboard
shortcuts.

Configuring Audio Settings
If you're using more than one sound card, or are experiencing unpredictable
playback or no audio, be sure to check your Audio Hardware settings under the
Preferences menu. Make sure you have selected the sound card or audio
device you want to output to, and that the buffer settings are high enough for
your computer's processing capabilities.

Supported Audio Import Formats
WAV, Broadcast WAV, AIFF, MP3, WMA, AAC, SD2, BWF, OGG, FLAC

Note:Mono audio files with (.L and .R) or (.1 and .2) extensions can also be
opened as either mono files or split stereo. See Preferences > Misc to control
this behavior.

Importing Audio From Video
RX can import the audio directly from a number of video formats, saving you the
step of extracting that audio in a separate application. Once you've worked with
the audio in RX, you can export that audio and reassemble the video in your
video editing program of choice.

RX requires having QuickTime to open QuickTime formats (like .MOV). 

Supported Video Formats
AVI, MPEG, Windows Media Video, MOV, M4V

File Format Support Note
RX uses your operating system’s available resources for opening certain file
formats.  Windows native formats (like WMA and WMV) may not open in OS X,
and QuickTime formats (like AAC, MOV, and M4V) may require installing
QuickTime on Windows and running RX in 32-bit mode.



File Saving
RX Documents are the default format for saving your work. RX Documents have
many benefits such as retaining undo history and other valuable information
about the work you’ve done to your audio files, so you can always review your
edits and even go all the way back to the original state of your audio file.

For RX 4, there are some changes to the default keyboard shortcuts:

⌘+S (Mac)
Ctrl+S (PC)

Save your RX Document

Shift+⌘+S (Mac)
Shift+Ctrl+S (PC)

Save your RX Document under a new file name

Option+⌘+S (Mac)
Alt+Ctrl+S (PC)

Overwrite Original File. When directly editing a WAV
or AIFF, this will overwrite the file on disk.

⌘+E (Mac)
Ctrl+E (PC)

Export your audio to a WAV, AIFF, FLAC or OGG Vor-
bis file

Note: If you’re used to the previous workflow, the Overwrite Original File
function works just as Save used to in previous versions, and you can even
customize your keyboard shortcuts to remap⌘+S or Ctrl+S to use this, in the
same way you can remap any keyboard shortcut in RX.

Transport Controls
The transport is located below the spectrogram and can be used to monitor the
input signal, begin recording, start and stop playback, rewind to the beginning of
a file, or play back a looped region within a file.

Playhead
To place the playhead, single click anywhere in RX's main
spectrogram/waveform display. To play back audio while positioning the
playhead, grab the seek handle at the top of the playhead or hold



Control/Command while clicking on the spectrogram/waveform display.

Current Time Indicator
The numeric value near the transport controls indicates the current position of
the playhead.  Depending on how your display is configured, this value is
shown in hours/minutes/seconds, time code, or samples.

Input Monitoring
Streams the signal from your selected sound card input as a reference for
setting levels for recording.

Record
Begins recording into a new file. One click puts recording into an armed state for
safely setting input levels.  The next click begins recording.  A third click stops
recording.

If you already have a file open, hitting Record will prompt you to create a new
file for recording.

Rewind [Return]
Brings you back to the start of the file.

Play [Spacebar]
Starts and stops playback. Starts or stops recording if Record is armed.

Play selected
When you've made a selection of a time range, frequency range, or both, this
button auditions just the selection (useful for isolating intermittent noises, etc.)

Loop [Control/Command-L]
Enable this switch to loop the selected audio.



Recording

Recording Audio
RX supports recording up to two channels at a time.

To record into RX, create a new file. 

Press the Record button once to enable Record Arm.  The level meters will
show the level of the signal coming into RX.

Verify that your input source is not clipping and that you have enough headroom
to accurately capture the entirety of your recording.  Adjust the gain coming into
your sound card if necessary. You can also enable Input Monitoring to hear the
input source without arming record. 

When your input levels are perfect, press Record again to begin recording.

When you are ready to stop recording, press Record a third time.  Your recorded
file is now ready for editing inside RX.

Until you save the file, your recorded audio data is stored in the RX 3 Session
Data folder.  You can set this folder’s location in Edit > Preferences > Misc.  If
you are recording into RX often, it is important to set this folder to your drive with
the most available free space.

Troubleshooting Recording
If you are having trouble recording in RX, try the following:

1. Enable Input Monitoring and look for activity on RX’s level meters.
2. Close other audio applications and DAWs open on your computer to

make sure no other program is usurping the sound card.
3. Open Edit > Preferences > Audio and make sure the correct device is

listed in Input Device.  Also check in the Channel Routing dialog to make
sure the correct inputs are selected.



4. Check your input source.  Make sure the hardware connections between
whatever you’re recording from and the inputs on your audio interface are
fine.

Spectrogram/Waveform Display
About the Spectrogram Display
The spectrogram and waveform display window combines an advanced
spectrogram with a transparency feature to allow you to view both the frequency
content and amplitude of a file simultaneously.

The spectrogram shows a range of frequencies (lowest at the bottom of the
display, highest at the top) and shows how loud events are at different
frequencies.

Loud events will appear bright and quiet events will appear dark.

The spectrogram can let you see at a glance where there is broadband,
electrical and intermittent noise, and allows you to isolate audio problems easily
by sight.

RX features an advanced spectrogram display that is capable of showing
greater time and frequency resolution than other spectrograms, allowing you to
see an unprecedented level of detail when working with audio.

Transparency Balance

The same audio file shown as its waveform, its waveform and spectrogram, and its spectrogram.



The transparency balance of the waveform and spectrogram can be adjusted
with the transparency slider to the lower left of the display.

The Spectrogram Display features a transparency slider that lets you
superimpose a waveform display over the spectrogram, allowing you to see
both frequency and overall amplitude at the same time. This can be invaluable
for quickly identifying clipping, clicks and pops, and other events.

Zoom
To the lower right of the display, you will find horizontal and vertical sliders. The
horizontal slider will affect how much of the time ruler is represented on the
screen. The vertical slider controls the frequency range shown in the
spectrogram or the amplitude range of the waveform display. You can choose
which range this zoom affects with the toggle switch next to the slider.

You can also zoom by placing your mouse cursor over a ruler and moving your
mouse wheel.

You can always zoom the time ruler by using the mouse wheel on the
spectrogram/waveform display.

Configuring resolution
The Spectrogram Display can be configured to show a high level of detail for
critical applications.

Vocal recording with default spectrogram settings



The same file with reassignment enabled in the Spectrogram Settings dialog

In situations where you would like to see crisper detail, go to the View >
Spectrogram Settings menu. There are presets in this menu for some of the
more useful settings.

Waveform Overview

An overview of the entire audio file's waveform will be displayed above the main
Spectrogram/Waveform display in order to provide a handy reference point
when zooming and making audio selections in RX. The Waveform Overview
will always display the entire audio file, and will also display any selections
made in the main display.



When zooming in to your audio, the currently visible audio region will also be
highlighted in the waveform overview. Click and drag on the highlighted region
in order to scroll your main audio display left or right, and click and drag on the
edges of the highlighted region in order to make the zoom tighter or wider. To
zoom out fully, simply double click on the highlighted visible region.

Note:With your mouse hovering over the waveform overview, you can also use
the mouse wheel to scale the amplitude of the waveform display to provide a
clearer overview. This will not affect the amplitude scaling in the main RX
spectrogram/waveform display.

Changing Spectrogram Colors

RX's Spectrogram Display also allows you to choose from different color
schemes. To choose from different color presets go to View > Spectrogram
Settings.

Spectrogram colors can be adjusted to different schemes, including colors from iZotopeOzone and
Iris,

andmulticolor maps that help reveal small magnitude differences

Vertical Rulers
On the right side of the spectrogram/waveform display are the amplitude ruler for
the waveform, frequency ruler for the spectrogram, and color map for the
spectrogram.

The RX interface will automatically hide and show rulers depending on the
spectrogram/waveform transparency balance slider.



Amplitude Ruler
You can right-click on the spectral amplitude ruler to reveal a selection of
amplitude scales.

dB shows waveform levels in decibels, relative to digital full
scale (it is the most common type of scale used for spec-
trum analyzers)

Normalized shows waveform levels relative to the full scale level of 1
16-bit shows waveform levels as quantization steps of a 16-bit

audio format (−32768 to +32767)
Percent shows waveform levels as percentage from full scale

Frequency Ruler
You can also right-click on the frequency ruler to reveal a selection of different
frequency scales:

Linear Linear scale means that Hertz are linearly spaced on a
screen

Mel (default)and
Bark

Mel and Bark scale are frequency scales commonly found
in psychoacoustics, and reflect how our ears detect pitch.
They are approximately linear below 500 Hz and approx-
imately logarithmic above. Mel scale reflects our per-
ception of pitch: equal subjective pitch increments produce
equal increments in screen coordinates. Bark scale reflects
our subjective loudness perception and energy integration.
It is similar to Mel scale, but puts more emphasis on low fre-
quencies.

Log In this mode, different octaves occupy equal screen space.
The screen coordinates are proportional to the logarithm of
Hertz down to 100 Hz.

Extended Log This extends the logarithmic scale down to 10 Hz, so that it
puts even more attention on lower frequencies.



Piano Roll Overlay
A representation of how specific frequency ranges correlate to the western
musical scale can be displayed by right clicking on the frequency ruler and
selecting Show Piano Roll.  If you would like to hide the frequency indicators so
they don’t obscure this piano roll, you can disable Show Frequencies and Ticks
(which is enabled by default).

Color Map
Shows what color represents what amplitude in the spectrogram.  The range of
this display is the dynamic range of the RX spectrogram.  You can click and
drag the map to change the range and use the scroll wheel to make the range
larger or smaller.  This is useful for seeing very quiet noises without using gain
to change the level of your audio.

Advanced Spectrogram Settings
Our spectrogram has been designed to provide more sharpness and detail than
other spectrograms. To adjust advanced settings like FFT size (frequency
resolution), window and colors, go to View > Spectrogram Settings.

Time Format Menu
The Time Format context menu is where you select your preferred time format
display in the time scale. It can be accessed by right-clicking the time ruler or by
clicking the arrow button to the left of the ruler. There are the following options:

Format The time scale displays...

Samples the sample counter, starting from 0
Time (h:m:s) time in hours, minutes, seconds, and mil-

liseconds, starting from 0
Timecode (n fps) the time code in hours, minutes, seconds,

and frames, starting from 0
Source Time (h:m:s) time in hours, minutes, seconds, and mil-

liseconds, starting from the clip's time code
origin

Source Timecode (n fps) the time code in hours, minutes, seconds,
and frames, starting from the clip's time
code origin



The value of n (the frame rate of the time code) depends on the setting you have
in the Time scale frame rate menu in the Misc tab of the Preferences dialog box.

There are two zoom options available from the Time Format menu:

Zoom Out Full The entire clip appears in the wave-
form/spectrogram display

Zoom to One Sample Per Pixel Zooms so that each screen pixel rep-
resents one sample of the waveform

Zooming
From RX's main window, you can zoom in horizontally and vertically on both the
waveform and spectrogram views.

Zoom Tools

Zoom in, zoom out, zoom to selection, zoom to whole file, zoom to left side/right side of selection

The zoom tools allow you to zoom in or out horizontally, zoom all the way out,
zoom to the current selection, or zoom to the left or right edge of the current
selection.

Zoom Sliders
The slider controls to the lower right of the spectrogram can be adjusted to
control zoom. The vertical slider can be set to control either the waveform or the
spectrogram: their ranges can be controlled independently.  The currently
selected mode for this control is indicated by the illuminated icon.



Timeline, waveform, and spectrogram zoom controls

Dragging rulers and using the Mouse Wheel
The rulers to the right and below the Spectrogram display can clicked and
dragged to reposition the spectrogram and waveform to show a different time
range, amplitude range or frequency range.
In addition the range shown can be adjusted with your mouse wheel, just place
your cursor on top of a ruler and the mouse wheel will adjust the zoom for that
ruler.
To reset any of the rulers to the default display range, double click on the ruler.
Note: All active selections will be accurately preserved and scaled when
zooming the main display.

Selection and View Ranges

The Selection and View range display gives you quick access to basic
selection and view controls.

The time display shows the current selection and view’s start and end position,
as well as length, in the currently selected time format. You can select a new
time format by right-clicking the time ruler under the spectrogram.



The frequency display shows the current selection and view’s frequency
boundaries and length.

Clicking on any of these fields will let you manually edit them.

Undo History
In addition to the Edit > Undo and Edit > Redo commands, the Undo window
allows you to see a time line of changes you've made and non-destructively
revert back to earlier states.

RX keeps a log of all your edits in the Undo History

You can also rename items in the undo history by double-clicking them.

Export History
You can then use the Export History feature to save an XML file, listing the
entire undo history for your particular file.

Autosave
RX is always saving your editing session, enabling you to pick up where you
left off the next time the application is launched, even in the event of an
application crash or power outage.
To keep you from losing any work pertaining to any audio file you currently have
open, RX will store every audio edit, effect or algorithm that is applied, your full
edit history list, and your last selection.
By default, when the RX application is launched, it will open the last editing
session and audio file that was in progress when RX was last quit.



Note: Saved session state recovery is ON by default.  The option to turn it off is
located under the Preferences > Misc tab as “Resume last editing session
when app starts”.

In the event that RX crashes in the middle of a restoration session, when RX is
next launched, you will be given the option to rebuild your session just before
the crash.



Backing up your work with RX
Documents

Save a file using the RX Document file format to archive your edits

RX Documents
RX’s session state can be stored in a portable document that includes your
original file, all the edits you’ve made to it, and your most recent selection and
view state.  This document is useful for archiving your work.

RX Documents can only be opened with RX.  If you need to save your file so it
can be opened somewhere else (like a DAW or media player), you need to
export it in another format (like WAV or AIFF).

To save an RX Document, select File > Save RX Document... and select
where you would like to store the file. 



Keep in mind that the size of the RX Document file can be very large, especially
if your list of edits include multiple processes on the whole file. 

Identifying Audio Problems
RX has many different tools for analyzing and repairing audio.

To get started, it is important to identify the problems in your audio and choose
which RX tool or tools will give you the results you want.

RX’s many tools will help you analyze your audio and find not only the problem, but the best
solution.

Get another view with the Spectrum Analyzer
In addition to the spectrogram/waveform display, RX offers a highly configurable
spectrum analyzer which displays the FFT information around your playhead or
selection.  Use it to get a detailed “side view” of the spectrogram and get
accurate details about tonal peaks.

Watch your levels with Waveform Statistics
Waveform statistics are important for managing levels, discovering amplitude
irregularities, honing in on distortions, and ensuring compliance with modern
loudness laws.  Get details about the peak and RMS levels of your selection, as



well as quick measurements of BS-1770 loudness statistics from this useful
utility window.

Recommended sequence of processing steps
Although each restoration case is different, we recommend checking out this
typical sequence of steps for repairing audio in RX.



Recommended sequence of processing steps

Note that Dereverb is not included in the chart: it can be anywhere, depending
on the situation, — although its most common place is next to the Denoiser.



Clipping
Clipping is a common problem that occurs when a loud signal distorts on input
to a sound card/converter, mixing console, field recorder or other piece of
equipment. The result is overload distortion. This clipping can usually be seen
most easily from RX's waveform display. As you will see in the image below, the
clipping appears as "squared-off" sections of the waveform.

Not all distortion is caused by clipping, but almost all clipping causes distortion!

RX has a dedicated Declip tool which can in many cases rebuild the squared-
off peaks caused by clipping and restore the recording to a natural-sounding
state.

Distortion
Not all distortion is caused by clipping.  If there is a distortion that can’t be
tackled with Declipper, try looking for a bright region of noise obscuring tones in
the middle of the spectrogram.

You can also hunt for it by making a frequency selection from 500 Hz to 5 kHz. 
After you make the selection, play back your frequency selection.  Move it
around or adjust the top and bottom of the selection until you hear exactly where
the distortion is located.



Once you have the distortion in your signal selected, use the Deconstruct tool. 
Deconstruct separates the file into tones and noise, then gives you independent
gain control over those parts of audio. 

Distortion before and after Deconstruct takes the edge out

Because distortion is like noise, try adjusting the noisy gain of your selection by
−3 or −6 dB. Play the file to hear your changes, and adjust the gain further if
necessary.

Clicks, pops and other short impulse noises
Clicks and pops are common on recordings made from vinyl, and can also be
introduced by some kinds of digital errors, including recording into a DAW with
improper buffer settings. These short impulse noises appear in RX's
spectrogram as vertical lines. The louder the click or pop, the brighter the line
will appear.



Clicks and pops from a vinyl record

RX's Declicker includes both automatic and manual tools for removing clicks
and pops.

Crackle and mouth noise
A continuous stream of quiet clicks is called crackle.  Crackle ranges from the
quiet but pervasive crackle of old degraded recordings to the smacks and clicks
present in close-miked vocals.

RX's Decrackle can easily remove continuous clicks running through a
recording.



Hum and buzz
Hum is usually the result of electrical noise somewhere in the signal chain used
for recording. It can often be heard audibly as a low frequency tone, usually
based at either 50 Hz or 60 Hz depending on whether the recording was made
in Europe or North America. In RX's Spectrogram display, you will be able to
see hum as a series of horizontal lines, usually with a bright line at 50 or 60 Hz
and several less intense lines above it at harmonics. See below:

60 Hz hum with three harmonics

60 Hz hum detail in the Spectrum Analyzer



In situations like this example, which has only a few harmonics, RX's Remove
Hummodule is the best tool for the job. Remove Hum lets you set the primary
frequency of the hum and lets you control suppression of up to seven harmonics
above the fundamental frequency.

Hum notched out with Remove Hum’s filters

In some cases, the electrical noise will extend up into higher frequencies. This
will often manifest itself as a background buzz.



Tonal high-frequency noises caused by interference or electrical problems can be handled
transparently with Denoise.

In situations like this example, where the hum's harmonics extend into high
frequencies, try using the Denoise module. In the Spectral Denoiser, unlink the
Reduction slider to reveal the Tonal reduction control, which can often control
high frequency buzz and other persistent background tones more effectively
than Remove Hum.

Interference and high-frequency buzz
Interference from GSM signals or very high-frequency signals like fluorescent
lights can make its way into recordings.  Very often, this interference is
represented on the waveform by a series of impulses.  You might have to zoom
in on the waveform significantly to see them.



This waveform detail shows that the bright harmonic buzzing of GSM noise is caused by rapid
impulses interfering with the desired signal.

Declick’s M-Band modes can help you tackle short bursts of loud interference
and take quiet continuous interference out of a signal.

A quick Declick pass removes much of the interference, improving the intelligibility of the audio.



Hiss and other broadband noise
Unlike hum and buzz, broadband noise is spread throughout the frequency
spectrum and not concentrated at specific frequencies. Tape hiss and noise
from fans and air conditioners are good examples of broadband noise. In RX's
Spectrogram display, broadband noise usually appears as speckles that
surround the program material.

Noise appears as speckled static on a spectrogram

RX's Denoise module is the go-to tool for removing noise of this type.



After denoising, the background noise in the file appears darker

Intermittent noises
Intermittent noises are different than noises like hiss or hum, they may appear
infrequently and may not be consistent in pitch or duration. Examples include
coughs, sneezes, squeaks, footsteps, car horns, cell phone rings, etc.



Find noises like coughs (left) or dishes rattling (middle) and select them with the Time/Frequency,
Lasso, or Brush tools.

Because noises like this are often unpredictable, they usually need to be
removed manually with a tool like Spectral Repair.

Gaps and dropouts
Sometimes a recording may include short sections of missing or corrupted
audio. These are usually very obvious to both the eye and the ear!



Half a second of missing audio from a vocal performance with vibrato and a change in pitch in the
orchestra

RX's Spectral Repair module has several algorithms for resynthesizing the
missing content.

Reverb
Reverb is the echoing decay of a sound in a space.  The right amount of reverb
in a recording can make a sound feel like it’s sitting in a natural space.  Too
much reverb in a recording, however, can interfere with intelligibility.  Reverb
can interfere with other processing as well, including dynamics and mixing.



The reverberant vocal performance (top) can have its lingering frequencies curtailed with Dereverb
(below).

Dereverb gives you control over the amount of reverb in your audio.  You can
use it to subtly push reverb lower, remove it completely, or even enhance it.



Batch Processing

A simple common batch process

Batch Processing allows you to automate processing on groups of files, or apply
multiple modules to files.

Job-Based Batch Processing
You can view the batch processing window at any time by selecting File >
Batch Processing. Each process in RX's Batch Processing window is split into
individual Jobs on the left. If there are no Jobs when the Batch Processing
window is first opened, one will be created automatically.

You can add a new Job by pressing the Add button.

You can remove the currently selected Job by pressing the Remove button.

To add files to a Job, click the Add Files button in the Input Files section of the
Batch Processor window or drag and drop in files fromWindows Explorer or OS
X Finder.



Processing Steps
In this area, you can define the specific processing chain that will be applied
sequentially to each file in the Input Files area above.

Use the drop-down menus to select which module you wish to use and click the
+ and − buttons on the right to add more steps to your processing chain. For
each module, you can use a specified preset or custom settings by clicking the
View button. Once you have the module settings the way you would like, click
on the Record button to save the settings into your processing chain.

Running a Batch Process
Once you are satisfied with the batch processing chain, use the options at the
bottom of the window to specify the destination directory, file naming behavior,
timestamp information, as well as the output file bit depth and dithering options.

When you are ready to run your Job, click the Process button. You will see a
progress dialog corresponding to each audio file while RX runs each Job. You
can cancel processing on an individual file by pressing the X next to the file
while it’s processing. To cancel the whole Job’s processing, click the Cancel
button that replaces the Process button.

You can run more than one Job at a time, if necessary.

Note: RX's batch processor will continue to run in the background, allowing you
to continue working with RX.

If you want to stop the Batch Processor from running to free up some CPU, but
want to continue your job later, you can use the Pause All button to suspend all
running Jobs.

By clicking on the Duplicate Processing Steps button, you can create new Jobs
based on similar processing chains of modules in RX.

Each Job will also be stored inside of RX independent of the audio files you are
working with, allowing you to save time by having predefined workflows and
processing chains to be reused for any future projects.



Keyboard Shortcuts
RX features many default keyboard shortcuts to make editing and workflow
easier. RX keyboard shortcuts can also be customized from the Preferences >
Keyboard menu.

Keyboard shortcuts can be edited easily by searching for the command you want and assigning a
new shortcut

Keystroke (Windows/Mac) What it does...

Tab Move the control focus to the next control

Enter Toggle buttons and check boxes On or
Off, select items from lists

Left/Right Arrow Increase and decrease value of control

Up/Down Arrow Navigate Up and Down in menus



Keystroke (Windows/Mac) What it does...

Page Up/Down Move controls by a large amount

Shift Hold while adjusting parameters to move
controls by a larger increment.

Control/Command Hold while adjusting parameters to move
controls by a smaller increment for greater
precision

Mouse Wheel Used to increase or decrease the value of
a control. Can also be used with Control
for more precision

Control/Command-N New file

Control/Command-Shift-N New file from clipboard

Control/Command-O File Open

Control/Command-W File Close

Control/Command-S Save RX Document

Control/Command-Shift-S Save RX Document As...

Control/Command-Alt/Option-
S

Overwrite Original File

Control/Command-Shift-E File Export Selection

Control/Command-Return Return Connect clip

Control/Command-Delete Discard Connect clips

Control/Command-F Toggles Full Screen on and off

Escape Switch from Full Screen view

Control/Command-G Toggles clip gain on/off

Spacebar Play/Stop



Keystroke (Windows/Mac) What it does...

Return Return-to-zero (Rewind)

Alt/Option-I Enable/Disable Input Monitoring

T Time selection tool

R Time-Frequency selection tool

F Frequency selection tool

L Lasso selection tool

B Brush selection tool

Control/Command +
Mousewheel
(with brush tool selected)

Adjust Brush size

W Magic Wand selection tool

Shift (hold with selection) Create multiple independent selections
with any tool

Alt (hold with selection) Remove the current Alt selection area
from any previous selection

Control/Command-D Deselect (breaks your current selection)

Shift Control/Command-D Reselect (recovers a previously broken
selection)

Control/Command-I Invert selection frequency

Control/Command-Shift-I Invert entire selection

Control/Command-Shift-H Select extra harmonics

Control/Command-L Toggle looping

Control/Command-R Toggle playhead return

Control/Command-P Toggle playhead follow



Keystroke (Windows/Mac) What it does...

Control/Command-Shift-P Cycle playhead follow mode

Control/Command-F Find next event

Control/Command-Shift-F Find next similar

Control/Command-Alt-F Find previous similar

Control/Command-Z Undo

Control/Command-Y Redo

Control/Command-X Cut

Control/Command-C Copy

Control/Command-V Paste

Control/Command-Alt/Option-
V

Paste Insert

Shift-V Paste Mix

Alt/Option-V Paste invert & Mix

Control/Command-Alt/Option-
Shift-V

Paste Replace

Alt/Option-Shift-V Paste to Selection

Del Delete (time selection) / Silence (other
selections)

Control/Command-A Select all

Control/Command-Comma Preferences menu

Shift-0 through 9, Shift-Alt-1
through 4

Show/hide processing modules

Control/Command-0 through
9, Control/Command-Alt-1
through 9

Apply processing modules to the current
selection



Keystroke (Windows/Mac) What it does...

Control-Shift-4 (PC)
Command-Shift-Option-4
(Mac)

Train Denoiser with current selection

Alt/Option-R Show/hide spectrum analyzer panel

Alt/Option-D Show waveform statistics window

Control-Shift-0 Toggle floating window opacity

Control/Command-Equals Zoom in

Control/Command-Hyphen Zoom out

Control/Command-Shift-
Hyphen

Zoom out full

Control/Command-\ Zoom selection

Control/Command-[ Zoom left edge

Control/Command-] Zoom right edge

F1 Help menu



Working with Selections

Selection Tools

Selection Modifiers (PC/Mac)

Selection Tools
Below the Spectrogram display is a Selection Tools menu that gives you
several options.

Time, Time & Frequency, Frequency, Lasso, Brush, Magic Wand, Zoom, andGrab tools



One of the key benefits of RX is that it allows many options for selecting audio
not just by time, but also by frequency. This allows you to do work with sounds
that fall in only part of the frequency range at a given point in your project. This
is very helpful for isolating and repairing a variety of audio problems including
intermittent background noises.

This selection by time and frequency isolates a background noise for processing

The Time Selection tool (T) allows you to select a range of time within
the file (horizontally within the spectrogram).

The Time-Frequency Selection tool (R) allows you to make
rectangular selections in the spectrogram display to isolate sounds by time and
frequency.

The Frequency Selection tool (F) lets you select by frequency only
(vertically in the spectrogram).

The Lasso Selection tool (L) lets you use your mouse to outline a
free-form selection in time and frequency in RX's spectrogram.

The Brush Selection tool (B) lets you draw a free-form selection
using a defined brush size in time and frequency in RX's spectrogram.

l The size of the Brush Selection tool can be adjusted by clicking and
holding on the Brush Tool icon.

Note:With the brush tool selected, you can also hold Control/Command and
move the mouse wheel to make the brush size larger or smaller.



The Magic Wand Selection tool (W) will automatically select similar
harmonic content surrounding the selected material.

l Click on spectrogram— the Magic Wand tool will automatically
select the most prominent tone under the cursor.

l Click on existing selection— the Magic Wand tool will auto-
matically select the overtone harmonics or related audio com-
ponents of your current audio selection.  You can use the Brush or
Lasso tools first to broadly define a sound and then use Magic
Wand to refine your selection to include relevant harmonic material.

The Zoom Selection tool (Z), when enabled, zooms into time and
frequency selections as you make them.

l Zoom Button— toggles zooming mode. When in zooming mode,
you can zoom in to time, time/frequency, and frequency areas. Hold
the alt key and click to zoom out.

The Grab and Drag tool (G) allows you to move around your view of
the spectrogram when zoomed in.

The Invert Selection button allows you to invert your entire selection.
This lets you select audio you want to preserve, then invert the selection and
apply processing to everything else in the file.

The Invert Frequency Selection button will invert only the frequency
content of your selection.  This lets you select audio you want to preserve, then
invert the selection and apply processing to other frequencies in the time range
of your selection.

The Select Harmonics tool will duplicate your current selection to
include harmonics above it. Start by selecting the fundamental frequency of
audio with harmonics, then add or remove harmonic selections with this tool
before processing.



Selection Modifiers (PC/Mac)
Add (Shift)
Hold down shift after making one selection in order to add another separate
selection. If any part of the new selection overlaps any other, the selections will
be grouped into one.

This can be especially powerful when combining multiple selection tools to
create multiple selections of different size and shape.

Rectangular, time, and freeform selections

Subtract (Alt/Option)
Holding down Alt/Option will allow you use the currently chosen selection tool
to remove or erase any portion of an existing audio selection. This can be
especially useful with the Lasso or Brush tools, allowing you to edit or refine any



piece of an existing selection.

Holding Alt/Option effectively turns the Brush tool into a selection eraser for
broad refinements and Lasso into a selection “X-Acto knife” for detailed
selection revision.

This is also useful for refining complicated free-form selections.  First make your
lasso, brush, or magic wand selection, and then hold alt while using the time,
frequency, or time and frequency tools to exclude entire time and frequency
ranges from processing.

Selections refined to perfection using the Alt key modifier

Note: Using Control/Command-Z to undo any particular process will also bring
back the previous audio selection exactly as it was before applying any
processing. In order to make use of this feature, be sure that Store Selections
with Undo History is enabled inside of RX's Preferences > Misc menu.



Seek (Control/Command)
Hold down Control/Command to move the transport's playhead to any position
without erasing your current audio selections. This can be especially useful with
previewing or comparing complex audio selections without having to remake
these specific audio selections.

Grab (Mouse Over)
After using any of RX's tools to select a portion of your audio, when the mouse
is subsequently placed on top of any selection, a Grab and Drag hand cursor
will be displayed automatically, allowing you to change the position of that
selection.

Channel Selection (Control/Command-Shift-L(eft)/R(ight)/B
(oth))
When working with a stereo file, it can be necessary to only process the left or
right channel of your audio file. To do so, simply make the selection that you
wish to process, and click on either of the channel selectors to the left of the
spectrogram/waveform main display.

This can also be used during playback in order to preview either the left or right
channel.



Channels can be selected and played back independently using the channel selectors and
keyboard shortcuts

Find Similar Events (Control/Command-F, Con-
trol/Command-Shift-F (Find Next), Control/Command-Shift-
G (Find Previous))
Sometimes you may have many events to manually repair throughout your file
that are similar. In cases like this, manually selecting and processing each
event can be time consuming. RX includes a Find Similar Event tool which will
take your selection, and move it to the next, or a previous, similar event.

To open the Find Similar Events window, go to Edit > Find Similar Event. Then
make a selection in the Spectrogram Display, and select Find Next to move to
the next similar event to the current selection.



If you are spot-repairing a similar event with Declick,
searching with the previous undo level will look
for something like the event you just repaired.



RX Modules
RX includes many audio restoration and repair modules designed to do
specialized tasks:

Restoration Modules:

Declip

Declick & Decrackle

Remove Hum

Denoise

Spectral Repair

Deconstruct

Dereverb

Production Modules:

Leveler

EQ Match

Ambience Match

Time & Pitch

Loudness



Utility Modules

Plug-in Hosting

Gain

EQ

Channel Operations

Resample

Dither

Working with RX Application
Modules

RX modules share several common features and controls.

iZotope RX is designed to give you a range of processing options. Most of RX's
modules feature multiple processing modes, ranging from fast algorithms that
sound great on most material to very time-intensive algorithms for critical
applications.

Understanding RX's Preview and Compare modes will help you save time,
especially when taking advantage of RX's more powerful processing modes.



Common Controls

Presets starting points or common settings for modules
Preview plays back a pre-rendered version of your current set-

tings
Bypass bypasses preview
Preview Options (+) preview pre-rendered buffer length settings
Compare send the current settings of the module to the Com-

pare window to audition against other settings
Process applies the module’s current settings to the audio file

or a current selection

Presets
From the Presets drop-down menu, you can select from default presets and
presets you have saved.  Presets saved in the RX application can be opened in
the RX plug-ins, and vice versa.

Preset Keyboard shortcuts
Individual presets and modules can be assigned to a keyboard shortcut in order
to recall and apply different modules and settings instantly. Simply select the
Set Preset Shortcut option from the Preset drop-down list in order to assign that
module and settings to a key.

Once the Preset is linked to a keyboard shortcut, you can select the audio you
wish to process with that Preset and simply press the shortcut key to apply that
preset's module settings to your selection.

This can maximize your workflow and provide incredibly quick and powerful
ways to work with RX's processing modules. These presets can also be applied
to any external plug-in in RX Advanced, allowing you to assign a plug-in and
settings to any particular key.



Module Preset menu

Add Preset Creates a new preset
Remove Preset Removes a preset from the drop-down list
Rename Preset Changes the name of a preset
Set Preset Shortcut Creates a keyboard shortcut for any preset in order

to recall and apply different module settings quickly
Import Preset Import a preset saved by another user or on another

computer
Explore Preset Opens a new window displaying your XML preset

files for that particular module
Reload Preset Rescan your preset directory for this module in

order to refresh the available preset list

By default, your presets are located at the directories below:

Windows Users



C:\Documents and Settings\<your username>\My Documents\iZotope\RX
4\Presets\

Mac Users

<username>/Documents/iZotope/RX 4/Presets/

Preview

Each RX module features a preview button that allows you to audition the
module's effect on the selected audio. By using preview, you don't have to apply
the process to the file to hear the result: you can click Preview and adjust
parameters as audio is playing back, allowing you to fine-tune module settings
without having to apply and undo them multiple times.

By making a selection in your file, you can preview just that selection. If no
selection is made, playback will start from wherever you have placed the
playhead (cursor) in the project's timeline. While in preview mode, you can also
have RX loop through a selection of audio by turning on the loop feature on
RX's transport.

Preview (Shift-Space)
Plays a pre-rendered preview of the module’s current settings on the selected
audio.



During preview, module settings can be adjusted. Adjustments will be heard
within the length of the current preview buffer (for most modules, about half a
second).

Bypass (Shift-B)
Bypasses preview. This feature is useful for A/B comparisons between the
original signal and the processed preview.

Preview Options (+):
l Preview Buffer Size— determines how long playback will be buffered
before starting

Buffering Playback
For more CPU-intensive settings, like Denoise's highest quality algorithms and
the highest quality Declick settings, RX can buffer playback to allow you to
preview these slower-than-realtime processes. To adjust how long the buffer is,
the menu next to the Preview button (+) opens the Preview Buffer Size control.
As audio plays back in preview mode, audio that is being processed will be
tinted red, showing you how far ahead of playback processing is happening.

Pre- and Post-Roll
When previewing an effect, it is often very helpful to hear a small portion of the
unprocessed audio before hearing your processed selection. This can provide a
much clearer comparison and allow you to more easily discern whether or not
the current processing settings are producing the desired effect.

By default, RX will play back one second of unprocessed audio before and after
the current selection when previewing your processing. The Pre- and Post-roll
times can be defined in the Preferences > Misc window. RX can play up to ten
seconds of audio before or after the previewed selection. Pre- and Post-Roll will
also occur when previewing a looped region of audio

Note: To turn OFF Pre- or Post-Roll, simply set the times in the Preferences >
Misc tab to 0.



TIP: Pre- and Post-Roll can also be simulated manually by holding
Control/Command to set the playhead to any desired position while preserving
your audio selection. Once the playhead is set, clicking on Preview in the
desired module will then start the Preview playback from the playhead's
position.

Compare

When you want to quickly try a lot of different settings, use the Compare feature.

In some cases, you might not know what settings of a module will give you the
best, most transparent results. By hitting the Compare button instead of the
Process button, you can audition multiple settings of the same module and then
audition the results side by side.

While one group of settings is processing in the background, you can return to
the module and try a different group of settings. Learning to use the Compare
tool can save you from having to apply and undo a process multiple times just to
find the right settings, making it a valuable time-saving feature.

Another advantage to using the Compare tool is seeing the effect your settings
have in the spectrogram and spectrum analyzer. 



Process Comparison List
Each time settings are sent to the Compare window, a new list item is created,
by default titled “Settings 1”, “Settings 2”, etc.

Preview
To hear (and see) the result of an item in the list, select that item and hit
Preview.

View Settings
Shows the module's settings used for processing.

Remove
Remove an item from the list.

Rename
Allows you to rename items with more descriptive names.

Process
Apply the selected list item to the audio file.

Working with RX Plug-Ins
RX plug-ins share several common features and controls.  The plug-in preset
system uses the same presets in the RX application, helping to provide a fluid
workflow between environments.  Every control you move is kept in the plug-in
history, and a flexible array of configuration options help you work the way you
want to. 

Presets

History

Input/Output

RX Plug-in Option



RX Connect Plug-in
The RX Connect plug-in sends a clip, or multiple clips, to the RX 4 standalone
application for editing and repair. This gives you access to all of RX 4's modules
in one place, and provides the benefits of RX's offline processing and visual
interface. RX Connect is available from the AudioSuite menu in Pro Tools, or as
an AU or VST plug-in from your host's effects menu.

To send clips from your DAW to RX 4 and back:

1. In your DAW, select a clip. If you are in Pro Tools, you can select more than
one clip. Note: RX 4 processes all clips on the same track as if they were a
single clip.

2. Do one of the following:

l In Pro Tools — select iZotope RX 4 Connect from the Noise Reduction cat-
egory in the AudioSuite menu.

l On a Mac — add the iZotope RX 4 Connect AU plug-in to the effects send
of the track that contains the clip or clips you want edited or cleaned.

l On a Mac or PC — add the iZotope RX 4 Connect VST plug-in to the
effects send of the track that contains the clip or clips you want edited or
cleaned.



3. Select one of the following:

l Send for reference—meant for analysis only. The clips go to RX 4, but
do not come back.

l Send for repair— the clips are sent to RX 4 for repair, and you can send
them back to your DAW.

3. If you are using RX Connect as a VST or AU plug-in, click Process, or follow
the host-specific instructions in the plug-in. In Pro Tools, click Send.

4. If you selected Send for repair, RX 4 opens. The repair clips appear as tabs
within a blue border in the RX 4 standalone application with the names “Pro
Tools 1” for the first clip, “Pro Tools 2” for the second clip, etc.
If you selected Send for reference, RX 4 does not automatically open, but
the clips will appear when you open RX 4.

Note: Some DAWs monopolize the system's audio drivers, preventing RX
from playing audio through the same output device. The RX Monitor plug-in
acts as an instrument in the DAW that plays audio from RX through the
driver being used by the DAW. If you are not able to hear the audio sent to
RX from your DAW via RX Monitor, change the audio driver to RX Monitor in
the Driver type menu on the Audio tab in the Preferences dialog box. See
RX Monitor.

5. When you are finished editing your clip in RX 4, click to send
the clip back to your DAW. If you want to discard your edits, simply close the
tab.

6. In the host, click Render.

For more information about using RX Connect with various DAWS, check out
the RX Connect FAQ.

Note: If you are running a virus protection software or a firewall on your
computer, you may need to grant permission for RX Connect to run.

https://www.izotope.com/support/kb/index.php/kb/article/644-rx_connect_faq


RX Monitor

When using RX Connect, some DAWs monopolize the system's audio drivers,
preventing RX from playing audio through the same output device.
TheRX Monitor plug-in acts as an instrument in the DAW that plays audio from
RX through the driver being used by the DAW.



The RX Monitor— connected to RX App

The RX Monitor— disconnected from RX App

To use RX Monitor



1. Click Edit > Preferences.
2. Click the Audio tab.
3. In the Driver type drop-down menu, select RX Monitor.
4. Click OK.

Note: If you are running virus protection software or a firewall on your DAW, you
may need to grant permission for RX Monitor to run.

Presets

Plug-in Preset Manager

From the Preset Manager, you can select from default presets and presets you
have saved.

To browse presets, press the Presets button and click the name of any preset.  If
you like what you hear, press the Presets button again to hide the window.

Add
Clicking this button adds the current settings as a new preset. You can type a
name and optionally add comments for the preset. Note that a few keys such as
* or / cannot be used as preset names. If you try to type these characters in the
name they will be ignored.



Note: This is because presets are stored as XML files for easy backup and
transferring. Their filenames are the same as the names you give the presets
(for easy reference) and therefore characters that are not allowed in Windows
file names are not allowed in preset names.

Remove
To permanently delete a preset, select the preset from the list and click the
Remove button.

Update
When you click the Update button your current settings before you opened the
preset window are assigned to the selected preset (highlighted). This is useful
for selecting a preset, tweaking it, and saving your changes to the existing
preset.

Import
Imports an RX 2 or RX 3 preset into the preset folder.

Folder
Opens a dialog that shows your current preset folder.  You can also select a
new preset folder from this dialog.

Renaming Presets
You can double click on the name of a preset to enter the edit mode and then
type a new name for that preset.

Cancel
Press Escape to close the preset system dialog and revert to the settings when
you opened the preset manager.



History

Plug-in History window

Pressing the History button opens the History window. This view gives you a list
of all of the actions you've performed inside the plug-in, allowing you to step
back to previous settings and undo changes.

Clear
Resets the History list.

Input/Output

Plug-in I/Ometers



Each plug-in features an input and output gain control and input and output
metering.

In stereo plug-ins, the gain controls are linked stereo gains.

RX Plug-In Options
General

Tools for managing your authorization and troubleshooting DAW/plug-in issues live here

Authorization & Updates

Check for Updates
RX can check the iZotope download servers for program updates by clicking on
the Check Now button or automatically upon launch of the application according
to the specified interval.

This option is initially set by the RX installer. If you don’t check for updates
when you install, RX will never check for updates again until you change this
setting.

Authorization
Shows the current state of your authorization.



If you need to authorize RX without restarting, you can press Authorize to
launch the Authorization Wizard again.

If you have upgraded to RX Advanced after owning the basic version, you can
press Remove Authorization. After removing your authorization, RX will enter its
demo mode.  You can now re-authorize the application using your new serial
number by clicking the Authorize button.

Choose Demo
Use this option if you are using the RX trial version and wish to try the RX
Advanced trial version or vice versa.

Host Performance

Latency
Some of the processing modes in the RX plug-ins are very CPU intensive and
result in a delay of the signal. That is, RX needs some time to "work on" the
audio before it can send it back to the host application. That time represents a
delay when listening or mixing down. 
Most modern DAWs and NLEs provide delay compensation — a means for RX
plug-ins to tell the application it has delayed the signal, and the host application
should “undo” the delay on the track (usually by adding compensating delays to
other tracks in realtime processing, or by adjusting the rendered file after
processing in offline processing).
When Enable Delay Compensation is enabled in the Latency menu, we will
report our latency to the host application.
If your application doesn't support it, or skips/stutters with this option on, you can
always manually correct the delay offset in the host application (manually edit
out the short delay of silence). To help you perform manual correction, the delay
RX introduces is shown below as Total System Delay in both samples and
milliseconds.
Disabling delay compensation can help prevent this delay when processing
offline in some older applications.
Freezing our reported latency value may help with delay compensation
problems during realtime processing in some older applications.



View Buffers
Shows buffer information from the host's track.

This is useful for diagnosing problems like audio dropouts or rare problems
caused by inconsistent buffer sizes.

Host Sync
Shows information reported from the host program about playback location, loop
and transport state, tempo, etc. (when applicable).
This is useful for diagnosing some rare timeline-related problems in specific
DAWs.

Denoiser Plug-in Options

Enable Multicore (C/D)
Enabling this option lets RX process Denoiser Quality Modes C and D more
efficiently by spreading its processing across multiple computer cores.

I/O (Input/Output Meters)

Fine tune your metering here

Meter Display Controls

Options for the combined RMS and Peak meter.



The RX I/O meter displays a lower bar representing the average level (RMS)
and a higher bar representing peak level. There is also a moving line above the
bar representing the most recent peak level or peak hold.

Peak hold time
If peak hold is on, you can choose different peak hold times. The choices are
250 ms, 500 ms, 1000 ms, 5000 ms and Infinite. If set to infinite, the peak value
will be held until you click on the current peak display.

Integration time
Specifies the integration time for RMS calculation. In most RMS meters, the
integration time is set to around 300 ms, which makes the RMS meter similar in
ballistics to VU meters.

Readout
Allows you to control what level value is displayed on top of the meters: peak or
actual (real time). If set to Max Peak, the display will show the highest peak
level.  If set to Current, the display will reflect the meter's current value.

Enable I/O meters
Turns the level meters on or off.

Show peak hold
Turns the peak hold display for the level meters on or off.

Repair Modules & Plug-Ins



Modules
Connect (plug-in only)

Declip

Declick & Decrackle

Remove Hum

Denoise

Dialogue Denoiser

Deconstruct

Dereverb

Declip
Declip repairs digital and analog clipping artifacts that result when A/D
converters are pushed too hard or magnetic tape is over-saturated.
Declip can be extremely useful for rescuing recordings that were made in a
single pass, such as live concerts or interviews, momentary overs in “perfect
takes”, and any other audio that cannot be re-recorded.
Declip will process any audio above a given threshold, interpolating the
waveform to be more round.  Generally, the process is as easy as finding the
clipping you want to repair, then setting the threshold just under the level where
the signal clips.
You can find clipping by either listening for the distortion that clipping causes, or
finding the high harmonic overtones of distortion in the spectrogram.



A waveform before and after clip repair.
The after example (bottom) shows the original repaired waveform (faded)

and the post-limiting waveform (bright). 



Declip Controls

Histogram Meter
Displays waveform levels for the current selection as a histogram. 

The histogram meter helps you set the Threshold control by displaying the
audio level where the waveform's peaks are concentrated. This usually
indicates at what level clipping is present in the file.

A histogram is an analytical tool that displays how many samples are present at
a given signal level over a window in time.  The longer the line for the histogram
is, the more energy is present at that amplitude.  If a lot of energy tends to collect
near the top and bottom edges of a waveform, that waveform is probably clipped
and distorted.



Clipped peaks in waveform, with histogram from selection

In the RX Application, select a section of the recording where clipping is
prominent and Declip will analyze the levels of the program material. If clipping
is present in the selection, it will usually appear as a horizontal line in the
histogram that extends all the way across the meter.

In the RX Plug-in, the histogram runs as a realtime meter.

The histogram’s range can be scaled if you need a better view of your signal.
Use the (+) and (-) buttons to scale your display and value resolution for the
declipper module. These buttons reduce (+) and/or expand (-) the range of the
threshold slider and histogram. You may want to extend the histogram range
when your clipping point is lower than what you can see on a histogram or if you
don’t see anything on the histogram.

If you are using the declipper control overlay on the waveform display, you can
use the mouse’s scroll wheel on the waveform amplitude scale to adjust the
threshold control resolution.

Threshold [dB]
Selects the clipping level used for detection of clipped intervals. Generally, this
should be set just below the actual level of clipping.



Note: Adjusting the Clipping Threshold will display a blue line within the
histogram and a gray line on the waveform itself. This gray line shows the level
on the waveform above which the declipper algorithm will process the audio file.
All sections of the waveform above this level will be regarded as clipping.
Within the histogram itself the elements of the file that will be processed (above
the blue line) will appear gray.

To set the threshold, move the Threshold slider until it lines up with the place in
the histogram just below where clipping is concentrated.

In the RX Application, you can set the Threshold slider automatically with the
Suggest button.

You can also set the clipping threshold from the RX waveform display.  By
default, Declipper Threshold is enabled in the Effect Overlays section of the
View menu.  When this option is enabled, you can see the relationship of the
Declipper Clipping Threshold settings to your file’s waveform, and make
adjustments to the setting by clicking and dragging on the red threshold line.

If you would like greater control resolution or need to apply Declipping to a
different amplitude range, you can adjust the amplitude range of the waveform
display by using the zoom control, clicking and dragging the amplitude ruler, or
using your mouse’s scroll wheel over the amplitude ruler.

Threshold Link

Toggles the ability to adjust positive and negative clipping thresholds
independently. 



When this option is enabled, you can adjust the positive and negative clipping
Threshold controls independently.  This is useful in cases where more clipping
is occurring on one side of your waveform.

You can also set asymmetric declipping thresholds directly from the waveform
by toggling the lock box between the threshold controls on the waveform
display.

This problematic waveform (grey) shears off around -13 dB on only the positive side of the
waveform (the histogram on the right shows the extra positive energy of clipped audio).  Extra

processing of the negative side would be unnecessary, so the Threshold controls can be unlinked
to process above -13 dBFS on the positive side only.  The resulting waveform is drawn in blue

above the grey sheared peak.

Suggest
Calculates suggested threshold values based on the levels in your current
selection.

Quality
Controls the interpolation processing quality.



There are three quality modes in RX's Declip: Low, Medium, and High. Low
quality mode processes very quickly; High quality mode processes slowly but is
capable of achieving better results. In many cases you will find that Low quality
mode gives you great results. To save time, always start by previewing the Low
quality modes first. You can also use the Compare feature to try multiple modes
and preview the results.

Makeup Gain (dB)
Selects the gain to be applied to the selection after declipping.

The declipping process causes an increase in peak levels.  The Makeup gain
control can be used to prevent the signal from clipping after processing.  It is
also useful for matching the level after processing to unprocessed audio outside
of the selection.

Post-limiter
Applies a true peak limiter after processing to prevent the processed signal from
exceeding 0 dBFS.

Declipping usually increases signal levels by interpolating signal segments
“above” the clipping point, which can make the signal clip again if the waveform
format offers no headroom above 0 dBFS.

If the post-limiter is disabled, the restored intervals above 0 dBFS can be safely
stored even without makeup gain as long as the file is saved as 32-bit float. 
Intervals above 0 dBFS will clip when played back through a digital-analog
converter.

Declick & Decrackle
Declick
Declick is useful for restoring old vinyl and other degraded recordings that are
riddled with clicks, pops and crackles.



Declick’s sophisticated algorithm analyzes audio for amplitude irregularities and
smoothes them out.  This means that you can use Declick to remove a variety of
short impulse noises, including clicks caused by digital errors, mouth noises,
interference from cell phones, or any other audio problem caused by impulses
and discontinuities in a waveform.

A noisy record before and after click removal

See Declick Controls.

Decrackle
Typically, the duration of a single click or pop will not be greater than 10 ms.
Decrackle is designed to handle a more continuous stream of irregularities in
your audio that become blended together at lower amplitude levels, resulting in
what we hear as crackle.

Decrackle is designed to tackle problems that Declick can’t handle. If a problem
can’t be fixed with Declick try processing with Decrackle.



In addition to crackle from degraded audio media like vinyl or lacquer discs,
Decrackle can also fix problems like clicks from dry-mouthed spoken word or
reed noise from woodwind instruments.

A recording before and after crackle removal

See Decrackle Controls.

Finding Clicks and Crackle
The Declick and Decrackle modules can look at a whole file, or a selection,
and detect and remove clicks and pops. For audio files that have clicks/pops or
crackle throughout the file, these modes are the best choice for efficient repair. If
there are a few hard-to-fix clicks left over after running the Declick/Decrackle
processes, Interpolate is useful for more precise control over repairing clicks.
Interpolate processes must be performed on each event individually, however.



Start by choosing the desired Algorithm type for your Declick module. Single-
band mode works very well with narrow “digital” clicks and has the advantage of
having a much faster processing time. The M-band (multiband) options work
well for wider vinyl clicks or thumps and perform great on very uneven audio
material such as old recordings.

Hit preview to hear the result of your settings. As audio is playing back, fine-tune
the Declick Sensitivity slider to increase the sensitivity of the click detector or
the Decrackle Strength slider to increase processing strength and remove more
clicks, pops, and crackle. The ideal setting should remove the most clicks
without damaging transients or the general integrity of the program material.

To better hear what is being removed, toggle the Clicks/Crackle Only control
during Preview playback. This will let you hear what is being removed from the
audio, allowing you to fine-tune your settings.

Note: For material with crackle/clicks or pops of very different sizes and lengths,
try running Declick/Decrackle in several passes.

Manual Interpolation
If problematic clicks still remain after running the other Declick modes, Declick’s
Interpolate mode can be used to process a region fewer than 1000 samples in
length. To locate clicks for manual interpolation, display both the waveform and
the spectrogram by double-clicking the spectrogram/waveform transparency
balance slider. Clicks will be visible as bright vertical lines on the spectrogram.
To select a click precisely, zoom in and inspect the waveform. While the
spectrogram will help with finding clicks, the waveform display will help you
accurately select click boundaries.



Use the spectrogram to spot clicks from a distance,
and the waveform tomake an accurate interpolation selection.

Select the click and press Process. The click will be removed using kind of
spectral attenuation from the surrounding audio data. Try adjusting the
interpolation Quality if your results are not satisfactory using the default settings.
If the click or pop is very long, Interpolate may cause a short level drop.

See Interpolator Controls.

Declick Controls

Algorithm
Controls the interpolation processing quality and configuration depending on
the type of clicks and pops in the audio.

n Single-band— processes quickly and works well on very narrow
“digital” clicks

n M-band (periodic clicks)—multiband processing for removing reg-
ularly repeating clicks with a wider spectrum, or regular clicks that have
concentrated low or high energy (like thumps or optical soundtrack per-
foration noise)

n M-band (random clicks)—multiband processing for wider vinyl clicks
and thumps, with a protective algorithm for preserving periodic audio ele-
ments characteristic to certain instruments such as brass or vocals



Click Type
Changes the Declicker controls to address specific kinds of clicks.

n Click— the default setting of Declicker.  Optimized to handle most
clicks.

n Thump— skews the click detector frequency response toward lower fre-
quencies to tackle thumps.

n Discontinuity—widens the click processing range to smooth out clicks
caused by waveforms that change suddenly in amplitude.

Sensitivity
Controls the sensitivity of the click detector.
Low values of this parameter will remove fewer clicks, while higher values can
repair too many intervals which can result in distortion.

Frequency Skew
Tunes the frequency response of the click detector.  Lower values will tune
Declick to handle more low frequency thumps.  High values will tune Declick to
detect and process more clicks in higher frequencies.

Click Widening
Controls the processing region around each detected click.  Increase this to
cleanly repair clicks caused by discontinuities or other digital waveform
problems.

Clicks only
Outputs the difference between the original and processed signals (suppressed
clicks).

Decrackle Controls



Quality
Controls the processing quality.  Low quality offers fast processing;Medium
quality will remove periodic, quickly repeating clicks; and High quality will help
preserve the tonal qualities of a signal.

Strength
Controls the amount of crackle that is detected and repaired.

Amplitude Skew
Skews the processing toward higher or lower amplitude crackle.  If the crackle
accompanies transients and other high-level signal passages (such as during
clipping), set this control more to the right.  If the crackle mostly happens during
low-amplitude signal passages, set this control more to the left.

Crackle only
Outputs the difference between the original and processed signals (suppressed
crackle).

Interpolate Controls

Quality
Defines the interpolation order, which controls how complex the synthesized
signal will be.  Changing this control can help interpolated audio fit into its
surroundings.

Remove Hum
Remove Hum is designed to remove low frequency buzz or hum from your
audio file.



Hum is often caused by lack of proper electrical ground. This tool includes a
series of notch filters that can be set to remove both the base frequency of the
hum (usually 50 or 60 Hz) as well as any harmonics that may have resulted.

Note: The RX Remove Hummodule is effective for removing hum that has up to
seven harmonics above its primary frequency. For hum that has many
harmonics that extend into higher frequencies (often described as "buzz"), try
using RX's Denoise module. For tricky hum problems, RX Denoise features
tonal noise reduction controls that can make short work of any extra-harmonic
hum and buzz.  Some very high frequency buzz can also be removed with the
Declick module!

Previewing the Hum
To begin, find the section of your audio where the hum is prominent. Sometimes
there will be silence (or near silence) at the beginning or end of the program
material that will contain noise but not any other audio. Otherwise, try choosing
a quiet passage of the recording where hum is obvious.

Finding the Hum's Frequency
When attempting to remove hum, you first need to find the hum's primary
frequency.

The Remove Hummodule can also automatically locate the root fundamental of
any hum in your audio. Simply make a selection containing the trouble
frequencies, and click the Learn button. This will automatically set the Base
Frequency to the result of the Learn calculation. RX can analyze any audio with
prominent hum, if you don’t have a passage of pure hum. This is, however, less
reliable than learning from only hum.

The two most common base frequencies that cause hum are 50 Hz (Europe)
and 60 Hz (U.S.). Under the Frequency Type field in the Remove Hummodule,
choose the appropriate frequency and then hit Preview to hear if this has an
effect.

In some cases, for example a recording made from analog tape that is not
precisely at its original recorded speed, you may need to choose the Free
Frequency Type. Selecting this option unlocks the Base Frequency control and



allows you to manually find the Hum's root note. With Preview engaged, move
the slider up and down until you find the point where the hum lessens or
disappears.

For even more precise settings, use RX's Peak Finding feature in the Spectrum
Analyzer window. Simply single click to place RX's anchor sample on top of the
hum you are trying to remove, and then drag your mouse over the peaks that
appear in the Spectrum Analyzer window to view the exact frequencies of your
audio.

Attenuating Hum's Harmonics
Because higher-frequency harmonics often result from hum, RX's Remove Hum
module has control for attenuating these overtones. Using the Number of
Harmonics control, you can select up to 7 harmonics above the primary hum
frequency. Again, the spectrogram display in many cases makes it easy to
identify the number of hum harmonics in your project. After selecting number of
harmonics, use the Harmonic Slope control to set how aggressively the higher
harmonics are being cut. The Filter Q control adjusts the width of the hum filters.

60 Hz hum with harmonics

Listening to Hum Only
By selecting the Output Hum Only checkbox, you can also hear the hum that is
being removed. This is useful for fine-tuning your settings. Play through a
section of your file where the hum is mixed with other material, select this mode,
and hit Preview.



Now you can adjust parameters like the Filter Q (width) control and the
Harmonic Slope control to maximize hum removal while minimizing the effect
on the program material.

A file before and after Remove Hum’s notch filters are applied



Remove Hum Controls

Base Frequency
Sets the base frequency of the hum to be removed. The two most common base
frequencies that cause hum are 50 Hz (Europe) and 60 Hz (U.S.). You can
manually specify a base notch by choosing the Free option. 



Note:When the Remove Hummodule's 'Base Frequency‘ is set to 'Free', you
can use the Spectrum Analyzer (under View > Spectrum Analyzer) and its
peak readout display to help find the exact peak frequency of any unwanted
hum.

Manual/Adaptive
Adaptive mode will allow the Remove Hummodule to adjust its noise profile
based on changes over time in the incoming audio. In this mode, RX will
analyze incoming audio for the specified learning time to determine what is hum
and what is desired audio material. Adaptive mode can work well with sources
that are constantly evolving.

In the Manual mode, the base hum frequency does not change over time.

Learn
Analyzes the current audio selection in order to automatically locate and set the
base hum frequency.

Filter Q
Controls the bandwidth of filters for base frequency and harmonics.

Linear-phase filters
Enables linear-phase FIR filters with a high FFT size.  Remove Hum’s linear
phase filters have a very accurate frequency response at the expense of latency
and filter pre-ringing.  When this is disabled, Remove Hum will use minimum-
phase IIR filters, which are only susceptible to post-ringing (which is usually
less noticeable than the pre-ringing introduced by FIR filters).

High-pass filter
Allows high frequencies to pass while attenuating lower frequencies.

n Frequency (Hz)— sets the cutoff frequency for the filter
n Q— sets the bandwidth of the high-pass filter



Low-pass filter
Allows low frequencies to pass while attenuating high frequencies.

n Frequency (Hz)— sets the cutoff frequency for the filter
n Q— sets the bandwidth of the low-pass filter

Number of Harmonics
Select the number of harmonics that need to be removed (1–8).

Link Harmonics
Links the gain of all of the filters, none of the filters, or odd/even filters.

Slope
When harmonics are linked, this controls the slope of the gain/suppression. As
the harmonic order increases, the gain/suppression level resolves closer to 0
dB.

Odd/Even Slope
When linking type is odd/even, this allows you to control the amount of
gain/suppression for both odd and even harmonics

Harmonic gains (dB)
Gives numerical readout of gain settings in dB. You can also manually type in
your gain settings for any of the harmonics.

Filter DC Offset
This removes the DC (direct current) offset that is caused by the imbalance that
sometimes occurs in A/D converters. DC offset is exhibited by the waveform
universally appearing above or below the zero line.

Output hum only
Outputs the difference between the original and processed signals (suppressed
hum).



Denoise
Denoise gives you control over the level of stationary noise in a recording.

Stationary noise does not significantly change in level or spectral shape
throughout the recording. Stationary noise includes tape hiss, microphone hum,
power mains buzz, camera motor noise, fans, highway traffic, and HVAC
systems.

The RX Denoiser is a flexible tool that can be used to quickly achieve accurate,
high-quality noise reduction.  It also gives you the control necessary to tackle
problematic noise with separate controls for tonal and broadband noise,
management of denoising artifacts, and an editing interface for controlling
reduction across the frequency spectrum.

RX has two Denoiser modes: Spectral and Dialogue.

Spectral Denoiser builds a spectral footprint of noise, then subtracts that noise
when a signal’s frequency drops below the threshold defined by the spectral
footprint.

The Dialogue Denoiser is a zero-latency denoiser optimised for fast, high
quality, automatic removal of stationary noise commonly found in location
recordings. 

Learning a Noise Profile
Denoise needs to learn the type of noise you want to remove from the recording
to give you the best results. To train the Denoise module, identify a section of
the recording that contains only noise, without any useful audio signal. Often
these places are at the beginning or end of a file, but may also be during pauses
or breaks in speech.

Select the longest section of noise you can find (ideally a few seconds), then hit
the Learn button. This will teach the Denoise module the noise profile of your
file.

Note: You can use keyboard shortcuts Control-Shift-4 on a PC or Command-
Shift-Option-4 on a Mac in order to train RX's Denoiser based on your current
selection.



Learning a Noise Profile From More Than One Selection
In the RX standalone application, it is possible to create a spectral profile from
multiple isolated selections.  This is useful if you have a file where it’s
impossible to select enough audio where only noise is present to build the
profile.

For example, if you are trying to restore a file where someone is speaking over
noise, you can select noise in frequencies where none of the voice is present at
any given time.  If you select enough of this noise with the Lasso or Brush
selection tools, you can create an accurate noise profile that will let you get
good results with the Denoiser.

You can create more than one selection at a time by holding Shift and making a
selection.

Select noise anywhere you can to build a better noise profile

This feature is only available in the RX standalone application because it
requires using RX’s spectral selection tools as well as accurate calculation of
the time and frequency of the selected areas.

If you are unable to create a full noise profile with multiple selections, RX can try
to build a reasonable noise profile out of your existing profile.  If you have an
incomplete noise profile, RX will ask you to if you want it to complete the profile.

For example, if you can only capture a low frequency rumble below 100 Hz,
some broadband noise between 200 Hz and 5000 Hz, and all the noise above
8000 Hz, RX can fill in the gaps for you.



Building a profile frommultiple selections gives you some flexibility, and RX will guess any noise
youmissed.

Selecting a Mode
Adaptive mode will track changes in the noise profile for a certain length of time. 
This takes some more memory and computational power, but is helpful for
tackling noise that shifts slightly over time (like the sound of street traffic or
ocean waves).



For most stationary noise, however, finding a good noise profile manually will
yield excellent results.  Using Manual mode gives you more control over what
makes up your noise profile.

The Dialogue Denoiser is designed to produce good results quickly, and
features an Auto mode that reacts quickly to shifts in background noise, but
keeps spoken word intact.  The Dialogue Denoiser’s Manual mode lets you
make refinements to the detected noise profile, and works well for cleaning up
busier audio, like musical recordings.

Reducing Noise
After you have a good profile, adjust the Reduction slider until the noise in your
signal is at the desired level.  Start with as little reduction as possible and slowly
bring the Reduction level up until the noise floor is at an acceptable level.

This is a good time to play with the Output Noise Only feature to hear what
you’re removing.

If the type of noise in your signal is more tonal than noisy (like hum or whine),
you can unlink the Reduction slider.  Having independent control over reduction
for different types of noise lets you achieve better results when processing
complicated noise profiles.

Refining Your Results
Once you have a good amount of reduction, you may want to adjust the
Threshold slider.  While adjusting the threshold, listen for artifacts like pumping
(dramatic changes in audio level) or gating (bursts of noise remaining after
useful signal). 

Lower thresholds will treat more signal like useful signal, and are useful if you
need to preserve audio material that descends gradually into quiet noise (like
orchestral tails). 

Higher thresholds are useful for achieving more reduction on transient material
(like drums or voice).

If your resulting audio sounds like it is missing some life or body, you can try
increasing the Quality setting.  Quality settings C and D can take advantage of
multicore processors to provide fast, high quality offline processing.



If you still hear undesirable artifacts in your results, you can try adjusting the
Artifact Control slider.  If you hear a musical noise artifact (the watery digital
“space monkey” artifact common to FFT-based denoisers), move the slider more
to the right (away from Musical noise).  If you hear a gating artifact (like pumping
or surges of background noise), move the slider more to the left (away from
Gating).

Shaping the Reduction Curve
If you need to improve your results, you can make adjustments to the amount of
noise reduction across the frequency spectrum.  This helps improve clarity in
higher frequencies, aggressively address low frequency rumble, or otherwise
tailor the processing to your audio.

You can create a useful Reduction Curve by creating a couple of points on the
spectrum, and then adjusting their positions.  Lower points push the noise floor
down.  Higher points bring the noise floor up.  The smoothness of the curve can
be adjusted with the Smoothing control.

For example, if you wanted to reduce some low HVAC rumble but preserve
some energy in higher frequencies, you could drag the curve’s leftmost point
down a little bit, then create a point around 5 kHz and drag it up a bit.

Note: You can axis-lock reduction curve points by holding Shift while dragging
them, and get very fine control over positioning by holding Control/Command.



This reduction curve helps tame a persistent high frequency noise without touching the rest of the
file.

A noisy vinyl record before and after processing with the above reduction curve.
Only the high band of hiss has been attenuated, and a new noise profile should now be trained to

address the rest of the background noise.

Scrolling and Zooming
By grabbing and moving the horizontal and vertical rulers, you can adjust what
part of the graph is shown. In addition, holding the pointer above a ruler and
using your mouse wheel will zoom the display in and out.

Attenuating Noise
After the noise profile is captured, select the whole file that needs to be
denoised. You can also make a time-frequency selection using the lasso, brush
or magic wand tools to denoise only certain frequency regions of the file.



A file before and after denoising

Denoise Controls
This section refers to the Spectral Denoiser and RX Denoiser plug-in controls. 
For Dialogue Denoiser controls, see the Dialogue Denoiser Controls section.



The RX Denoiser plug-in interface

Manual/Adaptive
RX Advanced users can chose between Manual or Adaptive mode.

Manual mode requires the user to train the Denoiser using Learn button. In this
mode, the noise profile does stays fixed for the duration of processing.

Adaptive mode will allow the Denoise module to adjust its noise profile based
on changes over time in the incoming audio. In this mode, RX will analyze
incoming audio for the specified learning time, decide what is noise and what is
desired audio material, and adjust its noise profile accordingly. Adapting noise
profiles can work well with noise sources that are constantly evolving,
particularly in post-production film settings or recordings from outdoor
environments.



Learn
Select a section, ideally at least a few seconds in length, where the noise you
want to eliminate is most prominent, and click the Learn button to learn the
noise profile. The selected noise section should contain no useful parts of the
signal. Otherwise they could be removed by the Denoiser.

If no single interval of noise exists in the recording, make multiple free-form
selections of noise in different parts of the file. The Denoiser will learn from them
and allow you to complete the noise profile.

Threshold (Noisy/Tonal)
Controls the amplitude separation of noise and useful signal levels.

Higher threshold settings reduce more noise, but also suppress low-level signal
components. Lower threshold preserves low-level signal details, but can result
in noise being modulated by the signal. Threshold elevation can be done
separately for tonal and random noise parts. A good default is 0 dB.

If background noise changes in amplitude over time (like traffic noise or record
surface noise), raise the Threshold to accommodate for the changes.

Reduction (Noisy/Tonal)
Controls the desired amount of noise suppression in decibels.

The Denoiser can automatically separate noise into tonal parts (such as hum,
buzz or interference) and random parts (such as hiss). The user can specify the
amount of suppression for these parts separately (e.g. in some situations it can
be desirable to reduce only unpleasant buzz while leaving unobjectionable
constant hiss). Strong suppression of noise can also degrade low-levels
signals, so it's recommended to apply only as much suppression as needed for
reducing the noise to levels where it becomes less objectionable.



The RX application Denoisemodule interface. Note that the Reduction sliders have been unlinked
to suppress the continuous tones separately from broadband noise.

Quality
Affects the quality and computational complexity of the noise reduction. This
selection directly affects CPU usage. RX's Denoise module offers four
algorithms that vary in processing time.

n A is the least CPU intensive process and is suitable for realtime oper-
ation. It reduces musical noise artifacts by time smoothing of the signal
spectrum.

n B achieves more advanced musical noise suppression by using adapt-
ive 2D smoothing (both time and frequency). It is more CPU intensive
and has more latency, but can still run in realtime on most machines.

n C adds multiresolution operation for better handling of signal transients
and even fewer musical noise artifacts. It is a very CPU intensive
algorithm and can only run in realtime on faster multicore machines.



n D adds high-frequency synthesis for reconstruction of signal details bur-
ied in noise. The speed of algorithm D is similar to algorithm C.

Artifact Control
Determines how much noise reduction will depend upon either spectral
subtraction or wide band gating.

With lower values, noise reduction will rely upon spectral subtraction, which can
more accurately separate noise from the desired audio signal, but can yield
musical noise artifacts, resulting in a “chirpy” or “watery” sound during heavy
processing.

With higher values, the noise reduction will rely more heavily upon wider band
gating which will have fewer musical noise artifacts, but sound more like
broadband gating, resulting in bursts of noise right after the signal falls below
the threshold.

Noise Spectrum Display
The Noise Spectrum display shows useful information during both playback and
when the noise reduction process is being applied.

Color Legend
n Gray (Input)— spectrum of input audio signal
n White (Output)— spectrum of the denoised output audio signal
n Orange (Noise Profile)— the learned noise profile plus offset from the
Threshold control

n Yellow (Residual Noise)— desired noise floor after denoising, can be
controlled by Reduction

n Blue (Reduction Curve)—manual weighting of the noise reduction
across the spectrum

Reduction Curve Shaping
n Reduction Curve— This feature allows for fine tuning of the reduction
spectrum with up to 26 edit points. This enables the user to customize
the amount of noise reduction being applied across different frequency
regions.  Higher curve values mean less reduction, lower curve values



mean more reduction.
n Add an edit point— Left-click, displayed as gray box along envelope
curve.

n Remove an edit point—Right-click or drag it outside the screen.
n Reset— This will remove all edit points.
n Smoothing— This controls the amount of interpolation between your
reduction curve points, allowing for sharper or more gradual edits.

Advanced Settings

Algorithm Behavior

FFT size (ms)
Selects the time and frequency resolution of the processing.

Higher FFT sizes give you more frequency bands allowing you to cut noise
between closely spaced signal harmonics, or cut steady-state noise harmonics
without affecting adjacent signals. Lower FFT sizes allow for faster response to
changes in the signal and produce fewer noisy echoes around transient events
in the signal.

Note:Whenever the FFT size is changed, it is recommended that the
Denoiser’s Learn feature is run again because the old noise profile was taken at
a different FFT size and therefore becomes inaccurate.

Multi-res
Enables multiresolution processing for the selected algorithm type.



When you select the Multi-res checkbox, the signal is analyzed in realtime and
the most appropriate FFT size is chosen for each segment of the signal. This is
done to minimize the smearing of transients and at the same time achieve high
frequency resolution where it is needed.

Note: The FFT size control does not have any effect in multiresolution mode as
the FFT resolution is selected automatically. The noise profile does not need to
be re-learned when switching to multiresolution mode.

Algorithm
Selects the smoothing algorithm for the removal of random ripples (“musical
noise” artifacts) that can occur in the spectrogram when processing your audio.

The strength of smoothing is controlled by the Smoothing slider.

n The Simple algorithm performs independent noise gating in every fre-
quency channel of FFT. Release time of sub-band gates is controlled by
the Release slider. This is a fast algorithm with small latency that is suit-
able for real-time operation.

n Advanced and Extreme algorithms perform joint time-frequency ana-
lysis of the audio signal which results in better quality and fewer
“musical noise” artifacts. These algorithms have higher latency and com-
putational complexity.

Smoothing
Controls the reduction of musical noise artifacts which can be a result of heavy
denoising. Musical noise is caused by random statistical variations of noise
spectrum that cause random triggering of sub-band gates. These artifacts are
sometimes described as “chirpy”, “watery”, or “space monkey” sounds left
behind during the noise reduction process.

Noise Floor

Synthesis 
Synthesizes high frequency material after denoising.



When Synthesis is set to a value greater than zero, signal harmonics are
synthesized after denoising.  The synthesized harmonics remain at the level of
the noise floor, and serve to fill in gaps in high frequencies caused by
processing.

Increasing Synthesis can increase the sense of life and air in processed audio. 
Too much Synthesis may cause apparent distortion in the signal.

Enhancement
Enhances signal harmonics that fall below the noise floor. 

Enhancement predicts a signal’s harmonic structure and places less noise
reduction in areas where possible signal harmonics could be buried in noise. 
This aids in preserving high-frequency signal harmonics that may be buried and
not detected otherwise. It can make the resulting signal brighter and more
natural sounding, but high values of harmonic enhancement can also result in
high-frequency noise being modulated by the signal.

Masking
Reduces the depth of noise reduction where you wouldn’t perceive any effect
from it.

If you need to cut very high, inaudible frequencies, set this to 0.  Otherwise,
leave this at 10.

Masking enables a psychoacoustic model that dynamically controls
suppression amount to facilitate the use of softer suppression where noise is
subjectively inaudible. When noise in certain regions is calculated to be
inaudible, this feature prevents any signal processing in these regions. This
potentially reduces amount of processing done to the signal and may positively
affect overall signal integrity. The position of the slider controls the influence of
psychoacoustic model on suppression levels.

Note: When this slider is set to 0, the feature is turned off, and the amount of
noise suppression is uniformly governed to the yellow curve in spectrum
analyzer (more precisely — by the difference between the yellow curve and
orange curve).



Whitening
Shapes the noise floor after processing to be more like white noise.

Whitening modifies the amount of noise reduction (shown by the yellow curve)
applied at different frequencies to shape the spectrum of the residual noise.

WhenWhitening is zero, the suppression is uniform at all frequencies, as
controlled by Reduction (tonal/broadband) sliders, and the suppressed noise
has a similar spectral shape to the original noise. WhenWhitening is maximal,
the desired shape of suppressed noise floor is made close to white, so that
residual noise has more neutral sound.

Changing the noise floor balance withWhitening can help prevent gaps from
over-processing, but an unnaturally white noise floor can introduce problems
like noise modulation when editing or mixing with other noises from a unique
space (like a set location).

Dynamics Characteristics

Knee
Controls how surgical the algorithm's differentiation is between the signal and
noise.

This slider controls the sharpness of the gating knee in the denoising process.
With higher values, transitions in the denoiser are more abrupt and can become
prone to errors in the detection of the signal with respect to the noise. When the
sharpness is reduced, the denoising becomes more forgiving around the knee,
and applies less attenuation to signals that are only slightly below the threshold.
This may result in a lower depth of noise reduction, but can also have fewer
artifacts.

Release (ms)
Selects the release time of sub-band noise gates in milliseconds.

Longer release times can result in less musical noise, but may also reduce or
soften the signals initial transients or reverb tails after the signals decay.



Note: The Release control is only available when the Simple algorithm is
selected.

Dialogue Denoiser
The Dialogue Denoiser is a simple, no-latency denoiser ideal for achieving
basic high-quality denoising on a variety of material with the minimum amount
of time spent tweaking controls.

The amount of denoising is determined by the noise threshold curve.  A higher
threshold generally means more noise reduction.  The noise threshold curve is
determined by the positions of the six threshold nodes.

The RX Dialogue Denoiser can intelligently analyze the signal and determine
the best noise threshold for your signal.  In a DAW, this feature can be used to
write automation in case you need to override the automatic settings and correct
the noise threshold by hand.

Under the hood is a series of 64 psychoacoustically spaced bandpass filters
which act as a multiband gate to pass or stop a signal based on user-defined
threshold values.  If a signal component is above the threshold for the filter, it
will be passed.  If a signal component is below the threshold for the filter, it will
be attenuated.

Dialogue Denoiser Controls
The Dialogue Denoiser is a simple, no-latency denoiser ideal for achieving
basic high-quality denoising on a variety of material with the minimum amount
of time spent tweaking controls.

The amount of denoising is determined by the noise threshold curve.  A higher
threshold generally means more noise reduction.  The noise threshold curve is
determined by the positions of the six threshold nodes.

The RX Dialogue Denoiser can intelligently analyze the signal and determine
the best noise threshold for your signal.  In a DAW, this feature can be used to
write automation in case you need to override the automatic settings and correct
the noise threshold by hand.

Under the hood is a series of 64 psychoacoustically spaced bandpass filters
which act as a multiband gate to pass or stop a signal based on user-defined



threshold values.  If a signal component is above the threshold for the filter, it
will be passed.  If a signal component is below the threshold for the filter, it will
be attenuated.

Auto
While in Auto mode, the Dialogue Denoiser will analyze the incoming signal
and adjust the noise threshold automatically to compensate for changes in the
noise floor. This can be useful for removing noise from recordings with variable
noise floor and continual noisy sections, and works well for almost any
recording of dialogue and spoken word. If you would like to use the Dialogue
Denoiser on musical material, the Manual mode is recommended.

Please note that the noise threshold settings in Auto mode may be different from
the settings set using only the Learn function in Manual mode.  Because the
adaptive noise threshold is continually being adjusted, it is set lower to prevent
artifacts from occurring during processing.



Manual
In Manual mode, the Threshold Nodes are set by hand or with the Learn feature.

Once set, Threshold Nodes don’t change position in Manual mode unless
automated by a host.  Use Manual mode if you feel that Auto does not yield the
results you would like or if you would like to write and read automation from a
DAW.

Learn
When the Dialogue Denoiser is set to Manual, you can use the Learn button to
set the noise threshold to a noise reference.

Find a passage of pure noise in your audio and use Learn to analyze it.  Longer
selections of noise will set the Threshold Nodes to more ideal locations.  We
recommend finding at least one second of pure noise. 

The Learn function analyzes the audio passing through the plug-in and adjusts
the Threshold Node controls automatically.  This is useful when used on a
section of audio that is only like the noise you want to remove so you can get a
more accurate result when removing noise from the rest of your audio.

Threshold Nodes
The Threshold Node controls on the frequency spectrum display allow you to
change the noise threshold curve, which can be thought of as the “noise profile”. 
These six points can be adjusted manually to suit the noise currently in your
signal.  These controls can be automated to compensate for shifts in the audio’s
noise floor.

In Auto mode, the Threshold Nodes are adjusted automatically in realtime.

In Manual mode, more than one Threshold Node can be selected at a time for
manual adjustment by clicking and dragging anywhere on the interface.

Threshold
The master Threshold control allows you to offset the noise thresholds plotted
by the Threshold Nodes. 



If you find that audio you would like to remain unprocessed is being processed,
try adjusting this control.

Reduction
Provides control over the maximal depth of noise reduction (in dB) that will
occur per frequency band while a signal component is below its threshold.  If
you have your thresholds set properly and don’t like the results you’re getting,
try adjusting this control.

Metering
The Input Spectrum meter shows the level of the signal at the input of the
denoiser filters.

The Output Spectrum meter shows the level of the signal at the output of the
denoiser filters.

The Gain Reduction Region is the area between the Input and Output Spectra
and shows the amount of processing currently happening to your signal.

Automation
Many Dialogue Denoiser controls, including the Threshold Nodes, are
automatable. The Threshold Nodes controls are updated continuously in Auto
mode or quickly with the Learn button. It is possible to use your DAW’s
automation recording and editing modes to easily change how the Dialogue
Denoiser is processing throughout your session.  If you are recording the
automation for the Threshold Node controls, you can have very flexible control
over the output of the Dialogue Denoiser in the following ways:

n Writing automation in your DAW by adjusting the controls in real time
while audio plays back

n Enabling Auto mode only during passages where the noise changes
n Revising settings later if necessary by switching to Manual mode and
editing the automation information in your DAW

To get the most out of the Dialogue Denoiser and your DAW’s automation
features, try recording automation with Latch mode.  Make sure the Dialogue
Denoiser is set to Manual mode so it can read back the automation you’ve
recorded!



Spectral Repair
Spectral Repair intelligently removes undesired sounds from a file with natural-
sounding results.

This tool treats areas selected in spectrogram/waveform display as corrupted
audio that will be repaired using information from outside of the selection.

When used with a time selection, it is able to provide higher quality processing
than Declick for long corrupted segments of audio (above 10 ms).

When used with a time/frequency, lasso, brush, or wand selection, it can be
used to remove (or attenuate) unwanted sounds from recordings, such as
squeaky chairs, coughs, wheezes, burps, whistles, dropped objects, mic stand
bumps, clattering dishes, mobile phones ringing, metronomes, click tracks, door
slams, sniffles, laughter, background chitchat, digital artifacts from bad
hardware, dropouts from broken audio cables, rustle sounds from microphone
movements, fret and string noise from guitars, ringing tones from rooms or drum
kits, squeaky wheels, dog barks, jingling change, or just about anything else
you could imagine.

Spectral Repair can also repair gaps or replace audio intelligently by using
advanced resynthesis techniques.

Spectral Repair has several tabs representing its different processingmodes.

Attenuate
This mode removes sounds by comparing what’s inside a selection to what’s
outside of it.



Attenuate reduces spectrogram magnitudes in the selected area to match
magnitudes from the surrounding area, resulting in the removal of the sound
without leaving an audible gap behind.

Attenuate does not resynthesize any audio. It modifies dissimilar audio in your
selection to be more similar to the surrounding audio.

This mode is suitable for recordings with background noise or where noise is
the essential part of music (drums, percussion) and should be accurately
preserved. It's also good when unwanted events are not obscuring the desired
signal completely. For example, this mode can be used to bring noises like door
slams or chair squeaks down to a level where they are inaudible and blend into
background noise. 

Replace
This mode can be used to replace badly damaged sections (such as gaps) in
tonal audio. It completely replaces the selected content with audio interpolated
from the surrounding data.

Pattern
This mode finds the most similar portion of the surrounding audio and uses this
to replace the corrupted audio.

Pattern mode is suitable for badly damaged audio with background noise or for
audio with repeating parts.

Partials + Noise
The advanced version of Replace mode. It restores harmonics of the audio
more accurately with control over the Harmonic sensitivity parameter.

This mode allows for higher-quality interpolation by explicit location of signal
harmonics from the 2 sides of the corrupted interval and linking them together by
synthesis.

Partials + Noise is able to correctly interpolate cases of pitch modulation,
including vibrato. The remaining of non-harmonic material (“residual”) is
interpolated using Replace method.



Processing Limitations
Depending on the mode and settings, Spectral Repair will have varying limits to
the amount of audio that can be processed in your selection.

n Unlimited— Attenuate when in Vertical mode only.
n 10 seconds— Attenuate Horizontal or 2D; Replace modes.
n 4 seconds— Pattern, Partials+Noise modes.

Longer selections will automatically adjust processing to use the correct mode.

Applying Spectral Repair
To start working with Spectral Repair, switch to the spectrogram view by
dragging the spectrogram/waveform transparency balance slider to the right.
Next, identify the unwanted event on a spectrogram and select it using a
selection tool. You can audition this selected time-frequency tile by pressing the
Play selection button in the RX transport.



Select the noise you want to repair and Spectral Repair will reduce it to the level of the noise floor,
replace it with audio from around the selection, or generate entirely new audio to fit the selection.

Note: Some unwanted events consist of several separate regions on a
spectrogram. In some cases, it's possible to achieve more accurate results by
repairing several smaller selections one by one, instead of one large selection.
Also, you can use the Find Similar Event tool to save time when searching for
and fixing many similar events in large files.

Once you've found the event(s) to repair, select the appropriate Spectral Repair
mode from the tabs at the top of the Spectral Repair settings window.
Sometimes it's worth trying several different methods or number of bands to
achieve the desired result. A higher number of bands doesn't necessarily mean
higher quality! We encourage you to use the Compare Settings window to
experiment and find the best settings for the project at hand.



Common parameters for many modes include Surrounding region length that
determines how far around the selection Spectral Repair will look for a good
signal. Before/after weighting allows you to use more information from either
before or after the selection for interpolation. For example, if your unwanted
event is just before a transient (such as a drum hit) in the audio, you may want to
set this parameter to use more of the audio before the selection to prevent
smearing of the transient into the selection.

Surrounding Region Shading
When using the Spectral Repair module, your selections will be shown with a
dotted line surrounding your selected region. This dotted line is directly
controlled by the Surrounding Region and Before/After Weighting controls
inside of your Spectral Repair modules, and provides a visual representation of
your set values.

The surrounding region is the region that RX uses for interpolation of the
selected region. The data from the surrounding region is used to restore the
selected region.

Spectral Repair Controls

Bands
Selects the number of frequency bands used for interpolation. A higher number
of bands can provide better frequency resolution, but also requires wider
surrounding area to be analyzed for interpolation. A lower number of bands is
ideal for processing short selections or transient signals.



Multi-Resolution
The multiresolution mode enables uses better frequency resolution for
interpolation of low-frequency content and better time resolution for interpolation
of high-frequency content.

The multiresolution processing option is available for each of the Spectral
Repair modes individually.

Strength
Adjusts strength of attenuation in Attenuate mode.

Direction
In Attenuate mode, Direction determines whether material to the left and right
(Horizontal), above and below (Vertical), or both horizontal and vertical (2D) is
used in repairing the selection.

Modes other than Attenuate all use Horizontal mode, and do not display this
option.

Surrounding region length
Defines how much of the surrounding content will be used for interpolation

Before/after weighting
Gives more weight to the surrounding audio before or after the selection

Pattern Search Range
In Pattern mode, selects the length of the audio segment used in a search for a
suitable replacement interval. For example, setting it to 5 seconds will allow
search within ±5 second range from the selection.

Harmonics sensitivity
Adjusts amount of detected and linked harmonics in Partials + Noise mode.
Lower values will detect fewer harmonics, while higher values will detect more
harmonics and can introduce some unnatural pitch modulations in the
interpolated result.



Using the Spectral Repair Plug-in in a DAW
Starting from RX 4, the Spectral Repair plugin is discontinued. It is replaced by
RX Connect — a plug-in for quickly sending audio into the RX standalone
application and back to the DAW.

Deconstruct

Deconstruct lets you adjust the levels of tones and noise independently in your
audio.

This module will analyze your audio selection and separate the signal into its
tonal and noisy audio components. The individual gains of each component can
then be cut or boosted individually.

This can be useful for a variety of audio files and applications, ranging from
increasing the “breathiness” of a flute to removing noisy distortion buried among
tonal content. The Deconstruct module may produce better results than the
Denoise module when the noise is highly time-variable, such as residual vinyl
noise after declicking/decrackling has been applied.

As opposed to Denoise, which separates signal from noise based purely on
frequency magnitude, Deconstruct analyzes the harmonic structure of a signal
independently of level.  It does not matter if a tonal signal like hum is quiet or
prominent in a signal. Deconstruct will always consider it tonal and adjust its
gain accordingly.



An oboe recording with tonal and noisy components

The noisy components of the recording, including breath and reed noise

The tonal components of the recording, including the prominent harmonics that form the timbre of
the instrument



Deconstruct Controls

Tonal Gain [dB]
Adjusts the gain of tonal components of the signal.

Noisy Gain [dB]
Adjusts the gain of noisy components of the signal.

Tonal/Noisy Balance
Balances Deconstruct’s separation algorithm between tonal and noisy audio
content.  Balance towards tonal will make Deconstruct consider some noisy
audio to be tonal and apply gains accordingly, and vice versa.

Dereverb

Dereverb gives you control over the amount of ambient space captured in a
recording.  It can make large cathedrals sound like small halls and make roomy
vocals sound like they were recorded in a treated space.



Reverb is the ambient sound of audio energy as it loses power in a space.  We
can think of a sound in a room as having two components: the direct sound and
its reverberant tail. The reverberant tail decays in power over time depending on
various factors, like the size of the space, the materials in it, and the geometry of
its construction.

Reverb tails also have an important time component: early reflections.  Early
reflections are the rapid echoes of a direct sound from a nearby surface.  They
are often distinct from the rest of a reverberant tail because they have a lot of
energy but end quickly. Early reflections typically comprise the first 5 to 100
milliseconds of a reverb tail.

If a listener (or a microphone) is close to the source of a direct sound, the direct
sound is perceived more than the reverb.  If a listener is farther away from a
direct sound, more reverb is perceived in relation to the direct sound.  A listener
moving away from the direct sound in a space will eventually cross a threshold
where the reverberant signal is perceived as prominently as the direct signal.

Dereverb processes audio according to the reverberant/direct ratio (also known
as wet/dry ratio) detected in the signal.  It can learn your audio to suggest some
frequency and decay time settings, or you can estimate these yourself.

Dereverb has the effect of sharpening a signal in time.  You can notice this transition in the
spectrogram: reverberant audio looks blurred, and cleaned audio appears more focused.  Here, a

recording of a distant speaker (left) has had its long tails processed (center) before another
Dereverb pass with shorter tail lengths to tackle the early reflections (right).



Learning a Reverb Profile

To find the best settings for your signal quickly,
find about five seconds of audio that starts with noise

and has both direct signal and reverberant tails.

RX Dereverb can suggest some settings based on your signal.

Find five to ten seconds of audio that starts with noise and has both a direct
signal and a reverberant tail. 

Direct signal, reverberant tail, and noise are all important to help Dereverb
understand your audio and set its controls appropriately.  It needs to understand
the ratio of dry signal to reverberant signal, how long reverb tails last, and where
the noise floor of your signal is (to avoid excessive processing).

If you are having trouble finding a good portion of audio to help Dereverb learn a
good reverb profile, try running the Learn feature on any transient audio where
both the direct signal and reverberant tail are apparent.

Complicated Reverbs
If the audio you are working with has a very complex reverb, such as a reverb
with apparent early reflections, you may get better results trying a few passes of
Dereverb.



First, start by training the Dereverb and set the Reduction amount to a value that
yields good results on the long reverberant tail.  After processing that, Learn a
new reverb profile and try reducing the level of early reflections: set the Tail
Length control to 0.5, Artifact Smoothing around 3.0, and increase Reduction.

A combination of Dereverb and Denoise can be used to tame very reverberant
signals.  It does not matter whether you process with Dereverb or Denoise first.

Dereverb Controls



Learn
Teaches Dereverb how much reverb is in your signal. 

The Learn feature analyzes the signal and determines the wet/dry ratio per
frequency of your signal, as well as the overall rate of decay of reverb.

When the Learn operation completes, the Reverb Profile and Tail Length
controls will be set to their suggested values.

The Learn operation can be performed on any reverberant audio.  We strongly
recommend using the Learn feature on a selection of audio that starts with some
noise floor (or room tone), is several seconds long, and includes both the direct
signal and its reverberant tails.

Try to find a good five-second slice of reverberant audio.  If you can find enough
direct signal and reverberant tails to fill the Dereverb signal trace meter while
using Learn, you will probably get a good reverb profile.

If you have trouble getting good results from using the Learn feature, you can try:

n learning on transient broadband audio, like drums, claps, or coughs.
n learning on any audio that is obviously reverberant.
n learning for a longer amount of time: most reverb can be analyzed in a
few seconds, but some reverb profiles can require up to ten seconds of
analysis.

Metering
The top meter shows a comparison between the input and output signal energy
over the past five seconds of playback.

The bottom meter shows the amount of reverb reduction over time. It is the
difference between input and output plotted on a flat line.

Both of the meters together give you an idea of what Dereverb considers reverb,
and help you refine your settings.

Reduction
Controls the amount of dereverb effect applied.



Larger amounts mean more reverb is removed.  Smaller amounts perform less
processing.

This control represents the target wet/dry ratio for processing.  In other words, if
it is set very high, it will treat the signal as though it has more reverb and
process it more.

If the output of Dereverb sounds unnatural after Learning, try slowly turning this
control down first.

Negative reduction will increase the amount of reverb in the signal.

Reverb Profile
Controls the amount of dereverb effect applied per-band.  These controls are set
automatically by the Learn feature.

If a group of reverberant tones are more prominent in a signal, increase the
control for that band.

Generally you want to set these controls to match the reverb originally present in
your signal.  For example, if reverb takes longer to decay (or is more present) in
a particular band, set that control higher.

These controls can also be used to address more prominent ringing or resonant
groups in signals.  For example, increasing the profile control for low
frequencies can remove muddiness from a resonant bass guitar, while
increasing the high band control can curtail ringing sibilance in live vocal
recordings.

Tail Length
Controls the decay of dereverb processing.

This control is an approximation of RT-60, the rate of time it takes for a
reverberant signal to decrease in amplitude by 60 dB.

This is automatically set by the Learn feature.

Increase this control if reverb tails reappear after processing, or if early
reflections are too apparent.



Decrease this control if reverb tails and noise floors sound over-processed, or if
the processed audio sounds dull.

This control can be set to its minimum setting to process early reflections.

Artifact Smoothing
Controls the frequency accuracy of dereverb processing.

Because reverb is generally smooth across the frequency spectrum, the default
value of this control is very high.  However, if you need more accuracy to
address issues like resonant tones in a room, you can decrease this control. 
The tradeoff is generally more artifacts from strong processing, so you may have
to balance adjusting this and the Reduction control.

Enhance Signal
Increases the level of the direct signal.

Boosting the non-reverberant signal can help create more dynamic range in the
signal, and is a good option to try when working with voice or transient material. 
Enabling Enhance Signal can also help prepare material for later denoising.

Output Reverb Only
Changes the output of Dereverb from the processed signal to the wet
reverberant signal. This is useful for monitoring the processing to get better
results.  Hearing just the reverb helps you understand the impact of controls like
Reduction, Reverb Profile, Tail Length, and Artifact Smoothing.

When this option is enabled, the output may not sound much like reverb
because it is the difference of processing against the original signal, with some
enhancement to expose more of the reverb apparent in the recording.



Production Modules

Modules
Leveler

EQMatch

Ambience Match

Time & Pitch

Loudness

Leveler
The Leveler module automatically rides the gain in your file to even out the
variations of the signal level. The algorithm consists of a compressor with a
makeup gain to achieve the desired Target RMS level. The compressor has the
ability to prevent pumping on speech pauses or breathing sounds (see Noise
Control slider). The level detector stage includes the K-weighting filter that helps
equalize the audible loudness, not just RMS level.

Unlike Loudness module, which applies a constant gain to the whole file,
Leveler applies a time-variable gain. For convenience of RX users, the time-
variable gain is applied as a Clip Gain envelope, which can be viewed and
edited by the user.



Leveler Controls

Target RMS
Sets the desired average RMS level of the recording. Note that Leveler uses K-
weighted RMS to better level perceived loudness.

Speed
Sets the integration time for RMS level detection. Similar to the attack/release
setting on a compressor.

Amount
The maximal amount of gain, in decibels, to be applied by the Leveler. The
Leveler will operate between −A and +A dB.



Noise control
This function detects noisy pauses or breaths in your signal and prevents
pumping (excessive gain) on such pauses. A higher percentage produces less
pumping.

EQ Match
The EQMatch module lets you match the EQ profile of a selection with the
profile of a different selection.

To EQMatch between selections:

1. Open the EQMatch module (Process > EQMatch, or by clicking EQ
Match in the modules list on the right side of RX.)

2. Make a selection in a file
3. Click Learn.
4. Make another selection.
5. Click Process.

To create an EQMatch preset:



1. In EQMatch, click Settings to the right of the preset drop-down menu.
2. Select Add Preset.
3. Enter the name for the new preset.
4. Press Enter.

Ambience Match
The Ambience Match module lets you match the noise floor of one recording to
another recording. For example, you can recreate the ambience of a live set on
your ADR tracks. The module analyzes the noise floor in your recording and
creates a snapshot of it, similar to the noise print in the Denoiser. Then you can
use this noise print to synthesize similar noise in another recording.

To train Ambience Match, provide it with a selection of raw noise. If there is no
single fragment of raw noise, or you want to save time, speech can be used.
The algorithm will intelligently discard speech and only leave noisy parts in the
noise print.

To match the ambience between selections:

1. Open the Ambience module (Process > Ambience Match, or by click-
ing Ambience Match in the modules list on the right side of RX.)

2. Make a selection in a file
3. Click Learn.
4. Make another selection.
5. Adjust the Trim level as desired. The Trim control adjusts the level of

synthesized ambience.
6. Select Output Ambience Only if you want the selection replaced with

only the ambience from the first selection.
7. Click Process.

Note: The Ambience Match module cannot reduce the amount of ambience that
already exists in the selection, it can only increase it. To reduce the ambience,
use the Denoiser.

To create an Ambience Match preset:



1. In Ambience Match, click to the right of the preset dropdown
menu.

2. Select Add Preset.
3. Enter the name for the new preset.
4. Press Enter.

Time & Pitch

Time & Pitch uses iZotope’s sophisticated Radius™ algorithm to give you
independent control over the length and pitch of your audio.  It is useful for
retuning audio to fit in a mix better, or adjusting the length of audio to deal with
BPM or time code changes.

Time & Pitch’s Pitch Contour tab can be used for faster pitch shifting with the
ability to correct variations in pitch over time.



iZotope Radius
iZotope Radius™ is a world-class time-stretching and pitch-shifting algorithm.
You can easily change the pitch of a single instrument, voice, or entire
ensemble while preserving the timing and acoustic space of the original
recording. iZotope Radius is designed to match the natural timbres even with
extreme pitch shifts. 

Algorithm
You should use Solo mode only when processing a single instrument with a
clearly defined pitch. The human voice is a good candidate for solo mode, as
are most stringed instruments, brass instruments, and woodwinds. For most
other types of source material, Radius mode will usually offer better results. If
speed is important, use the Radius RT mode.

Solo
In Solo mode, the adaptive window size can significantly affect the quality of
Radius's output. If the adaptive window size is too small, you will hear a
squeaking noise which sounds like the pitch of the audio is changing very
rapidly. If the adaptive window size is too large then the sound will become
grainy as you will begin to hear portions of it being repeated.

A good approach is to start with the default window size of 37 ms. If the results
are unsatisfactory, increase the window size until the squeaking noise
described above does not occur. If you cannot get the distortion to disappear,
switch to Radius mode for processing.

Lower pitched instruments and voices may require a longer adaptive window
size than the default, but very long adaptive window sizes can cause audible
repeating slices of audio.

Formant Correction
Formants are the resonant frequency components of voice that tend to be
perceived as characteristics like age and gender.  You can shift formants
independently of pitch and time by enabling Shift Formants.



Typically you will leave the Formant Shift Strength set to 1 (full strength) and the
Formant Shift Semitones set to 0. If you hear what sounds like an EQ
adjustment to your audio, you can try lowering the strength to reduce this
artifact. To achieve special effects, for example to change the perceived gender
of a human voice, try adjusting the semitones to a value other than 0.

Time & Pitch Controls

Stretch Ratio
Determines how much the resulting audio will be stretched in time. Values
between 12.5% and 100% will cause the audio to speed up without affecting
pitch, resulting in a shorter audio file. Values between 100% and 800% will



cause the audio to slow down without affecting pitch, giving you a longer audio
file.

BPM Calculator
If you are using Radius to process audio for a tempo change, you can also
adjust the stretch ratio with the BPM Calculator.

Pitch Shift
Controls the amount of pitch shifting up or down that will be applied to the audio.

Algorithm
The Algorithm drop-down menu has three options:

n Radius— designed to work well with polyphonic material such as
mixes with more than one instrument, as well as non-harmonic material
such as drum loops or rhythmic audio. This is the highest-quality option
for most sources.

n Solo Instrument— designed for monophonic pitched material such as
a stringed instrument or human voice.

n Radius RT— good quality, polyphonic, but faster than Radius.

Advanced

Transient Sensitivity
Determines the algorithm’s handling of transient material. Higher values will
result in better preservation of individual transients after processing.

When stretching percussive material, you usually want transient sensitivity set
to its default value of 1.  If transients in your audio are being “smeared”, a higher
value of 2 will tighten up transience at the expense of incurring heavier
processing on non-transient audio.

Bowed instruments such as the violin and cello are especially affected by the
transient sensitivity setting. If you hear a stuttering artifact, lower the transient
sensitivity to eliminate it.



Noise Generation (Radius mode only)

Helps noisy material (like sibilance or snare drums) sound more natural when
processed.

This control will generate noise instead of stretching the noise that is already
present in the signal and creating new tones. Higher values of the noise
generation parameter will cause Radius to generate noise more often, but can
cause some phase artifacts.

Pitch Coherence (Radius mode only)
Controls the preservation of the natural timbre of the processed audio.

The Pitch coherence control in the Radius control panel helps preserve the
timbre for pitched solo voices, such as human speech, saxophone or vocals.
While traditional vocoders can smear these signals in time and randomize
phase, the pitch coherence parameter of Radius preserves phase coherence for
these signals.

High values of pitch coherence will avoid phasiness in Radius's output at the
expense of roughness (modulation) in processed polyphonic recordings. Try
turning this up for better results if you’re processing a solo voice or a small
group of related instruments.

Phase Coherence (Mix mode only)
Preserves the coherence of phase between the left and right channels of the
processed audio.

This should be increased if there's any change in the perceived stereo image
after using Radius. It can be decreased when processing a multichannel signal
where different channels contain completely different instruments.

Adaptive Window Size (ms) (Solomode only)
Adjusts the window size in milliseconds of Radius' Solo algorithm.



If the adaptive window size is too small, you will hear a squeaking noise which
sounds like the pitch of the audio is changing very rapidly. If the adaptive
window size is too large then the sound will become grainy as you will begin to
hear portions of it being repeated.

Increase this if you have trouble getting good results pitching or stretching low-
pitched instruments or voices.

Shift Formants
Processes formant frequencies independently of other pitch and time
processing.

When this option is enabled, formant frequencies can be shifted independently
of other pitch shifting performed by Radius.

When Radius performs pitch-shifting without Formant Correction, it will shift
these resonant frequencies along with the rest of the audio.

n Strength— adjusts the amplitude strength of the formant correction fil-
ter.

n Shift— how much formant frequencies are shifted. Typically this control
can be set to 0, which leaves the formant frequencies unshifted during
processing. Adjust this control to fine-tune the formant correction
algorithm or for special effects.

n Width— controls the bandwidth of the formant detection filter. Smaller
values of this control will offer more precise formant correction in the pro-
cessed audio.  Higher values will include a wider band of formant fre-
quencies.

Pitch shifting single instruments (especially bass instruments) can benefit from
some adjustments to formant correction. Try enabling formant correction and
moving the strength between 0.1 and 0.2. Move the Formant Correction
semitones part of the way towards your pitch shift amount. For example if you're
pitch shifting +4 semitones, move the Formant Correction Semitones between 2
and 3. This can help bring back subtle percussive elements in the original
source material.



The formant frequencies of the human voice can actually shift slightly when we
sing. You can use the Formant Correction Semitones control to compensate for
this. For example, if pitch shifting a human voice by +7 semitones, try setting the
Formant Correction semitones between 0 and +2 for more natural results.

Pitch Contour
The Pitch Contour mode of Time & Pitch module lets you change the pitch of a
selection over time.  This can be used to quickly correct small pitch variations or
gradual pitch drifts over time.

The Pitch Contour changes pitch by continuously changing the playback speed
of the audio.  The effect is similar to speeding up or slowing down a record or
tape deck while it is playing back.

Because the Pitch Contour uses resampling to synchronously change time and
pitch, it cannot be used to adjust pitch without also adjusting time.

Pitch Contour Controls



Pitch Contour
The horizontal axis shows the length of your current selection.  If you have no
selection, the horizontal axis represents the entire length of your file.

The vertical axis shows the amount of pitch shifting that will be applied. A curve
through the top half of the display will create a higher shift in pitch and shorten
the audio correspondingly.  A curve through the lower half of the display will
create a lower shift in pitch and lengthen the audio correspondingly.

You can correct a gradual pitch drift over time by adjusting the points at the far
left or right of the display, drawing a straight sloping line from the beginning of
your selection to the end.  These points are locked to the vertical axis.

Clicking on the contour display will create a new pitch node. You can create up
to 20 pitch nodes to achieve very complicated pitch shifts.

Clicking and dragging a pitch node to move it around will change the pitch
curve.

Double clicking on a pitch node will set its value to 0 (no change at that point).

Right clicking on a pitch node will delete it.

Holding control/command while dragging will give you fine control over a pitch
node’s position.

Smoothing
Larger values create a smoother pitch curve when multiple pitch nodes are
present.  This is useful when correcting a non-linear change in pitch.

Reset
Clears all pitch nodes and returns the Smoothing control to its default value.

Loudness
The Loudness module adjusts the gain of the signal in order to meet the
specified loudness standard, such as BS.1770. Unlike the Leveler module, the
gain in Loudness module stays fixed in time. However a post-limiter will be



applied to the signal, if it is required to meet the True Peak specification.

To use Loudness:

1. Make a selection in your file. If you want to apply Loudness to the entire clip,
click Edit > Select All or Edit > Deselect All.

2. Click Process > Loudness.
3. Select a preset, or make adjustments to the following sliders:

l Integrated loudness
l True peak

4. Click Process.



Loudness Controls

Loudness standard
Specifies the loudness standard used for calculating loudness and sets
Integrated loudness and True peak sliders to the target values typical for the
standard.

Integrated loudness
Sets the desired loudness of the clip.

True peak
Sets the maximum true peak value allowed in a clip.

Note that some combinations of Integrated loudness and True peak level may
be incompatible. For example, having loudness of −10 LKFS is not compatible
with a true peak value of −20 dBTP. When settings are incompatible, the
Loudness module will display a warning at the end of the processing pass.

Utility Modules

Modules
Plug-in Hosting

Gain

EQ

Channel Operations



Resample

Dither

Plug-In Hosting
RX supports the use of VST, AudioUnit (AU), and DirectX plug-ins. To enable
the use of plug-in hosting, open the Plug-In module.

You can run RX in 32-bit mode if you need to use 32-bit VST, AU or DirectX
plug-ins.

In Windows, run the iZotope RX (not iZotope RX 64-bit) shortcut from the Start
Menu.

In OS X, select iZotope RX in the Applications folder, right click it, and select
Get Info.  You can use this menu to configure which mode RX runs in.

Note:When used as a VST in RX, iZotope Insight's loudness history does not
run during offline processing. You will not see metering details, unless you are
using Preview.

Selection Based Processing
With a plug-in loaded into RX's Plug-in module, you can make use of the same
audio selection tools and Preview and Compare options that are available for
other RX modules.

This can allow for very detailed processing and greater accuracy when working
with your existing plug-ins, giving you audio selection options unavailable in a
traditional DAW setup.

Plug-In Presets
Only one plug-in may be loaded at a time. However, with the use of presets,
multiple settings and presets may be recalled quickly in order to move between
plug-in instances.

When your plug-in is configured the way you would like it, select Add Preset
from the small Preset drop down arrow.



Assign Presets to Keyboard Shortcuts
Once your preset is named and saved, you can then assign that plug-in and
preset to a keyboard shortcut with the Set Preset Shortcut feature.

This keyboard shortcut will recall not only the plug-in settings, but the plug-in
instance itself. As such, if a preset is saved with Plug-in 1, and Plug-in 2 is
currently loaded into RX's plug-in window, pressing the preset keyboard
shortcut will re-instantiate Plug-in 1 and recall the exact settings when the
preset was made.

This can allow for very quick editing, processing, and recall of plug-in instances
and settings, providing a quicker workflow than traditional DAW track/mixer
environments.

Gain
The gain module is useful for bringing the level of your audio up or down. Gain
can also be applied to a specific time-frequency selection, allowing you to
manually attenuate or boost selections in the Spectrogram window.

Controls for common tasks like normalization and fades are also in the gain
module.

Gain Controls

Gain

Boosts or cuts the level of the signal by the designated decibel amount.



Normalize

Applies enough gain to set the sample peak level of your signal to the specified
Target Peak Level.

Fade

Applies a gradual increase or decrease to gain throughout your selection.

Different amplitude curve options are available in the Fade Type menu. For in-
phase tonal material, a Cosine fade curve will work well, while the Equal power
fade type can be more effective on noisy material.

Fade Type

Log Logarithmic fade for general use
Linear Linear fade for general use
Cosine Cosine fade for crossfades of in-phase tonal audio material
Equal power Equal power fade for crossfades of noisy audio material

EQ
RX includes a six-band parametric EQmodule with four adjustable notch filters
and two adjustable passband filters. The EQ is useful for manually shaping the
overall sound of a file or selection.



EQ can often be a simple first step to preparing a file for restoration, and can be
used for cutting harsh high frequencies, removing rumble from dialogue, steeply
high passing out wind noise from a location recording, or cutting distortion
overtones to increase the intelligibility of a voice.

EQ Controls

To adjust the EQ curves, grab an EQ node and drag it to a new point on the grid.
When a node is selected, handles on either side of it appear which can be
dragged together or apart to control the bandwidth of the node. Alternately, you
can enter precise EQ settings by typing values into the table below the main EQ
grid.



EQ type
Options include Analog and Linear Phase.

n Analog (IIR)— a minimum-phase EQ.
n Linear Phase (FIR)— a linear-phase EQ.

FFT size
This controls the number of bands, i.e. frequency resolution vs. time resolution,
for the FIR filter.  Increase this to achieve steeper slopes and better low
frequency resolution at the expense of filter ringing.

Frequency and Gain
The white circles mark each filter band. You can adjust an EQ band by clicking
on a circle and dragging it to change the frequency and gain of the band.

You can click and drag to select multiple filter bands.

Q/Bandwidth
If you move the mouse over the white bracket handles on the side of the band,
you can adjust the Q or bandwidth of the EQ by dragging with the mouse and
widening the band.

You can also adjust Q of the selected filter with the mouse wheel.



Visuals
As you adjust a band you will see two EQ curves. The bright blue curve is the
composite of all EQ bands while the dark blue curve shows the EQ curve of the
selected band.

Table
If you'd rather use numbers as opposed to visual EQ bands, there is also a table
view of the EQ band settings. You can enter values for the EQ bands directly in
this table. You can also disable bands with this table by clicking on the check
box above the band.

Channel Operations
Channel Operations contains tools for quickly adjusting the amplitude, time, and
phase qualities of any channel in a file.

Many restoration tasks require a simple rebalancing of levels.  Channel
Operations corrects a number of issues with the stereo relationship of two
channels, including variable level problems, phase imbalance, timing, and
stereo noise in an otherwise mono signal.

Mixing



Provides specific control over both left and right signal and balance levels.  This
simple operation can be used to downmix stereo material into mono, invert
waveforms, transcode left/right stereo into mid/side, subtract a center channel,
and much more.

Left Output Mix (%)
Allows you to define how much of the current selection’s left and right channel
signal will be present in the new target left channel.

Right Output Mix (%)
Allows you to define how much of the current selection’s left and right signal will
be present in the new target right channel.

Phase

Balances asymmetric waveforms by rotating signal phase.  Rotating the phase
of a signal changes its peak values but doesn’t change its loudness, and
otherwise has no audible effect on the signal. 

Asymmetric waveforms can occasionally occur in audio such as dialogue,
voice, and brass instruments. Making the waveform more symmetrical gives the
signal more headroom.

By rotating the phase of a waveform, you change its amplitude characteristics. 
Phase rotation does not result in a time shift.

Because the range of rotation is from −180 to +180 degrees, the Phase tool can
be used for simpler purposes, such as inverting signal polarity.



The waveform on top is a trumpet signal with higher peak values on one side of its waveform.
The lower waveform has been rotated in phase by −72 degrees to distribute its peak samples more

evenly.

Adaptive Phase Rotation
Continuously analyzes the audio selection and applies the time-variable phase
rotation to both left and right channels, resulting in a symmetrical waveform with
minimal signal peak levels.

Adaptive phase rotation is best used on vocal material, as it can occasionally
yield pitch artifacts on musical material.

Rotation (deg)
Rotates the channel’s phase by the specified degree.

When a waveform’s phase is rotated, every frequency is rotated equally. 
Rotating phase by 180 degrees inverts the waveform.



Suggest
Analyzes the selection for the ideal channel-linked fixed phase for reducing
overall peak levels of the signal.

Azimuth

Provides control over left and right channel gain and delay.

Azimuth adjustment can help repair stereo imbalances and phase issues that
can occur with improper tape head alignment or other speed related issues.

Level (dB)
Adjusts the gain of the left and right audio channels

Adaptive Matching
Enables automatic time-variable adjustment of the right channel gain in order to
match the level of the left channel.



Delay (samples/ms)
Allows for manual adjustment over the delay in samples or milliseconds of the
left and right audio channels.

For very accurate azimuth correction, RX uses oversampling to achieve sub-
sample delays.

Adaptive Azimuth Alignment
Enables automatic time-variable adjustment of the right channel's sample delay
in order to align the waveform with the left channel.

Suggest
Analyzes the selection and determines the appropriate amounts of fixed gain
and delay to apply in order to align the two channels.

Extract Center

Preserves or removes the center of a stereo file.

Extracting the center will retain the center of a stereo field and attenuate
everything on the sides, such as signals panned to the left or right.

Center channel extraction will preserve a stereo image if the side channels are
retained.  This can make it more desirable in some cases than Mid-Side
encoding (which would sum left and right hard pans into one channel).



It is often a good idea to make sure stereo channels are balanced by running
Azimuth correction before using Extract Center.

Keep Center
When the signal you want to preserve is even in both channels and noise is
uneven between channels, extracting the center can remove a lot of noise.

For example, a mono record transferred to a stereo tape would have side
channel noise that would be suppressed by extracting the center channel.

Keep Sides
If you want to preserve the wide stereo information and remove the center
information, you can keep the sides of the signal instead.  This is useful for
karaoke-style removal of vocals from a song, especially because the process
results in a coherent stereo image.

Two different algorithms can be selected:

n True phase— cancels the center with phase information and retains
the original panning of the sides.

n Pseudo pan— extracts the side information and artificially stereoizes it
into two channels.

Reduction Strength
Controls the level of the preserved signal.  Smaller amounts will keep more
information, larger amounts will discard more information.

Resample
Resample allows you to convert an audio file from one sampling rate to another.

Sample Rate Conversion (SRC) is a necessary process when converting
material from one sampling rate (such as studio-quality 96 kHz or 192 kHz) to
another rate (such as 44.1 kHz for CD or 48 kHz for video).



It is common to record and edit in high sampling rates since higher rates allow
higher frequencies to be represented. For example, a 192 kHz audio sample
can represent frequencies up to 96 kHz whereas a 44.1 kHz audio sample can
only represent frequencies up to 22.05 kHz.  The highest frequency that can be
represented accurately by a sampling rate is half of the sampling rate, and is
known as the Nyquist frequency.

When reducing the sampling rate, or downsampling, it is crucial to remove the
frequencies that cannot be represented at the lower sampling rate. Leaving
frequencies above this point causes aliasing. Aliasing can be heard as the
frequencies in an inaudible range are shifted into an audible range, causing
distortion and noise. With iZotope SRC's steep low-pass filter, users can
completely avoid the common aliasing artifacts while maintaining the maximum
frequency content.

You can also engage the Post-limiter option in order to limit the output level of
your signal to below 0 dBFS to prevent any clipping from occurring.

Resample Controls



New Sampling Rate
This setting chooses the sampling rate you want to convert to. Choose a
sampling rate from the drop-down list, or click on the field to type in another
arbitrary sampling rate.

Change Tag only
Changes the declared sampling rate of the file in the file’s properties without
resampling the file, effectively changing the playback rate and pitch of the file.

This feature is useful if the sampling rate tag was damaged by a previous audio
editing process, and the file is playing back incorrectly.

Filter steepness
This allows you to control the steepness of the SRC filter cutoff. The white line
is representative of an ideal low-pass filter.

Higher filter steepness means better frequency performance of the filter: wider
passband retains more useful signal, while stronger stopband attenuation
provides better rejection of aliasing. At the same time, higher steepness of the
frequency response requires a longer filter, which produces more ringing in time
domain and energy smearing near the cutoff frequency.

Cutoff shift
SRC filter cutoff frequency shift (scaling multiplier).

Allows shifting the filter cutoff frequency up or down, to balance the width of a
passband vs. amount of aliasing.

Pre-ringing
SRC filter pre-ringing amount in time domain (0 for minimum phase, 1 for linear
phase, or anywhere in between).

Adjusts the phase response of the filter, which affects its time-domain ringing
characteristic. The value of 0 produces a minimum-phase filter, which has no
pre-ringing, but maximal post-ringing. The value of 1 produces a linear-phase
filter with a symmetric impulse response: the amount of pre-ringing is equal to



the amount of post-ringing. Intermediate values between 0 and 1 produce so-
called intermediate-phase filters that balance pre- and post-ringing while
maintaining linear-phase response across a possibly wider range of
frequencies.

Post-limiter
Keeps all output sample peak levels below 0 dBFS to prevent any clipping from
occurring.

This option is important when resampling signals very close to 0 dBFS,
because filtering during resampling can change the peak level of a signal.

Note: The Aliasing portion of the curve displayed in red shows the reflected
frequencies during downsampling or imaged frequencies during upsampling —
both due to aliasing.

Dither
Dither is a necessary process when converting from a higher bit resolution to a
lower bit resolution.

Dithering is used to tame the quantization distortion that happens when
converting between bit depths due to requantization. Dither also preserves more
of the dynamic range of a signal when converting to a lower bit depth.

The Dither module applies iZotope's MBIT+ dithering and noise shaping
technology to maintain the highest audio quality possible when you are
converting to 24, 20, 16, 12, or 8 bits.

MBIT+ uses psychoacoustic methods to distribute dithering noise into less
audible ranges. The result is a more pleasing sound and smoother fades.



Dither Controls

New bit depth
This sets the target resolution (bit depth) of the audio file.

Noise shaping
Chooses the aggressiveness of dither noise shaping.

It is possible to provide more effective and transparent dithering by shaping the
dithered noise spectrum so less noise is in the audible range and more noise is
in the inaudible range.

You can control the aggressiveness of this shaping, ranging from None (no
shaping, plain dither) through Ultra (roughly 14 dB of audible noise
suppression).

More noise shaping can cause slightly higher peaks in your signal, even at high
bit depths.



Dither Amount
The dithering amount can be varied from None (noise shaping only) to High. In
general, the Normal dither amount is a good choice.

No dithering or Low dither amount can leave some non-linear quantization
distortion or dither noise modulation, while higher settings completely eliminate
the non-linear distortion at the expense of a slightly increased noise floor.

A dither amount setting of High with no noise shaping produces a standard
TPDF dither: a common white noise generation method with a triangular
distribution of amplitudes between −1 and +1 of the Least Significant Bit (LSB).

Auto-blanking
Mutes dither output (i.e. dither noise) when the input signal is completely silent
(0 bits of audio).

Limit noise peaks
Dither noise is random in nature and has a very low amplitude. However, after
noise shaping, especially in aggressive dithering modes like Ultra, the high-
frequency dither noise is significantly amplified, and the overall dither signal can
show spurious peaks up to −60 dBFS during 16-bit quantization. If such high
peaks are undesirable, you can enable this option to effectively suppress the
spurious peaks in the noise-shaped dither.

Suppress harmonics
If, for some reason, any dithering noise is undesirable, simple truncation
remains the only choice. Truncation results in harmonic quantization distortion
that adds overtones to the signal and distorts the timbre. In this case you can
enable Suppress Harmonics option to slightly alter the truncation rules, moving
the harmonic quantization distortion away from overtones of audible
frequencies. This option doesn't create any random dithering noise floor.
Instead it works more like truncation, but with better tonal quality in the resulting
signal. This option is applicable only in the modes without dithering noise and
without aggressive noise shaping.
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New

Creating a New File (Control/Command-N)
To create a new file in RX, open the File menu and select New...

You will be prompted for the name, sample rate and channel count of the file
you would like to create.

New from Clipboard (Control/Command-Shift-N)
If you have existing audio data in your clipboard (for example, if you have
copied a selection from an existing file in RX), you can open the File menu and
choose New from Clipboard. A new file will be created with the correct sample
rate and channel count.



Open

Opening Audio Files (Control/Command-O)
There are many ways to open a file in RX:

1. From the File menu, selectOpen... and select the files you want to open.
2. Drag and drop a file from your operating system into the RX UI.
3. Drag a file from Finder/Explorer to the RX icon in the Dock/Desktop.
4. Double-click in the empty space of RX display.

RX supports having up to 16 files open at once.  To navigate between files
currently open in RX, either click on the file’s tab at the top of the RX UI, or use
the Control-Tab and Control-Shift-Tab keyboard shortcuts.

If you right click on a file tab, you can see some more options for managing tabs
and finding files on your hard drive.



If you have a lot of files open, you can access extra tabs through the arrow
button that appears next to the file tabs.

Supported Audio Import Formats
WAV, Broadcast WAV, AIFF, MP3, WMA, AAC, SD2, FLAC, OGG Vorbis

Note:Mono audio files with (.L and .R) or (.1 and .2) extensions can also be
opened as either mono files or split stereo. See Preferences > Misc to control
this behavior.

Importing Audio From Video
RX can import the audio directly from a number of video formats, saving you the
step of extracting that audio in a separate application. Once you've worked with
the audio in RX, you can export that audio and re-assemble the video in your
video editing program of choice.

RX requires having QuickTime to open QuickTime formats (like .MOV). 
QuickTime support is limited to 32-bit RX.

Supported Video Formats
AVI, MPEG, Windows Media Video, MOV, M4V

File Format Support Note
RX uses your operating system’s available resources for opening files. 
Windows native formats (like WMA and WMV) may not open in OS X, and
QuickTime formats (like AAC, MOV, and M4V) may require installing QuickTime



on Windows and running RX in 32-bit mode.

Export

Export Selection
This option will allow you to export only the audio that is contained within your
current selection, as opposed to the entire audio file.

When exporting, you will be able to define the output file name, directory, and bit
depth.

To export a selection to a file:

1. If you want to export a selection, click the Time selection tool ,

Time frequency selection tool , or the Frequency selection tool
and make one or more selections.

2. Select File > Export.

The Export File dialog box appears.

3. Make selections in the Export File dialog box according to the following
table:



Setting WAV AIFF FLAC Ogg

Bit depth
l 16-bit
l 24-bit
l 32-bit
(float)

l 32-bit
(int)

l 16-bit
l 24-bit
l 32-bit
(float)

l 32-bit
(int)

l 8-bit
l 16-bit
l 24-bit

Not applic-
able

Dither
l None
l White
noise
(TPDF)

l Noise
shap-
ing
(MBIT-
+)

l None
l White
noise
(TPD-
F)

l Noise
shap-
ing
(MBIT-
+)

l None
l White
noise
(TPDF)

l Noise
shaping
(MBIT+)

N/A

BWF Output a
Broadcast
Wave
Format
file.

N/A N/A N/A

Compression
level

N/A N/A Adjusts the
compression
strength of
the FLAC
encoder.
Stronger
compression
requires
more CPU
time during
file encoding
but results in

N/A



Setting WAV AIFF FLAC Ogg

a slightly
smaller file.
FLAC com-
pression set-
ting does not
result in any
quality
change to
the signal
since FLAC
is a lossless
format.

Quality N/A N/A N/A Adjusts the
bitrate of the
Vorbis com-
pression
algorithm.
Higher
audio quality
requires a
higher
bitrate and
results in a
bigger Ogg
file.

Preserve
non-audio
data

Exported
file retains
original
file's
metadata

Exported
file retains
original
file's
metadata

N/A N/A

Reopen file
in RX

Opens the
file in a
new tab in
RX

Opens the
file in a
new tab in
RX

Opens the
file in a new
tab in RX

Opens the
file in a new
tab in RX



4. Click OK.
5. In the dialog that opens, enter a file name in the file name field and nav-

igate to where you want to save the file.
6. Click Save.

Export Regions to Files
RX allows you to export multiple regions of any audio file that has regions. (See
Markers and Regions.)

To export regions:

1. Select File > Export Regions to Files.
2. Choose the exported file format in the Export dialog.
3. In the File Save dialog box, navigate to where you want to save the

files.
4. If you want, enter a prefix for your series of files in the Optional prefix

field. If you opt to not to add a prefix, the names of the files will be the
names of the regions. If any regions have the same name, numbers will
be appended sequentially.

5. Press Save.

Export Screenshot
RX allows you to export your current spectrogram/waveform display as a PNG
image file. This can be very helpful for archiving any restoration process or for
forensic documentation.



When clicking on Export Screenshot from the File menu, your current
spectrogram/waveform view will be used for adjusting your screenshot size and
position.

Note: The spectrogram/waveform transparency balance must be set before
selecting File > Export Screenshot as this cannot be changed in this window.

To define the size of your screenshot, simply click and drag in order to enlarge
or shrink the screenshot window. The dimensions of your resulting screenshot
will update automatically, however these can also be entered manually by
clicking once in eitherWidth or Height.

Note: The max resolution attainable for your screenshot will be limited by the
individual computer's screen resolution.

When you are finished changing the dimensions of your screenshot, click on the
Save button to name and save your .PNG screenshot to your chosen directory.

To save screenshots faster (at the expense of having a larger file on disk),
disable Maximum image compression.



Export History
For forensic and archival purposes, it is often useful to have an official record of
all edits that were made to a particular file.

When a file's history is exported, the following information will be stored in an
XML file:

n RX Version Number
n Time and Date
n Corrected File
n Number of Channels
n Sampling Rate / Bit Depth
n Edit History: Parameters and Selections

Close
(Control/Command-W)
Closes the current file.  If you close a file that has uncommitted changes
(represented by a dot or asterisk next to the file name in the tab display), RX will
ask you if you want to save the file.

RX does not ask about saving files when the application is closed because your
changes are retained in its session data.

Close All (Control/Command-Shift-W)
Closes all open files quickly.  If you have any uncommitted changes in open
files, RX will prompt you to save for every unsaved file.

Save
Refer to File Saving section to learn about the new way to save files in RX 4.



File Info
The file info dialog box has two sections: General Info and More Info. The
following table describes the information in each section.

General Info section

Information Description

Name The current filename
Duration Length of the file
Sampling rate The original sampling rate of the file
Bit depth The original bit depth of the file
Channels Mono or stereo
Size on disk Size of the file in bytes
File path Location of the file on your computer

More Info section
The More Info section lists information dependent on the file type. The following
is a list of possible entries in the More Info section:

l Timecode
l Created by
l Originator reference
l Date created
l Time created
l BWF version
l Coding history
l Track Title
l Artist
l Album
l Date
l Track Number



l Comment
l Genre

Edit
Undo (Control/Command-Z)
Reverses the last action taken.

Redo (Control/Command-Shift-Z; Control/Command-Y)
Cancels the undo.

Note: RX features an Undo History window, which logs a detailed list of all
actions taken, and lets you navigate through them.

Cut (Control/Command-X)
Removes the currently selected audio and stores it temporarily on the
Clipboard.

Copy (Control/Command-C)
Makes a copy of the currently selected audio and places it on the Clipboard.

Paste (Control/Command-V)
Places audio that has been copied or cut to the Clipboard at the current cursor
point.

Paste Special
Provides additional options for placing the Clipboard data

Insert
(Control/Command-Alt/Opt-V)

Inserts the audio from the Clipboard
and moves audio in the project (does
not overwrite)

Replace
(Control/Command-Alt/Opt-Shift-V)

Replaces audio in the project with
audio from the Clipboard



Mix
(Shift-V)

Combines the audio from the Clip-
board with audio in the project

Invert and Mix
(Alt/Opt-V)

Inverts the audio in the Clipboard and
then mixes it with audio in the project.
This is useful when you want to com-
pute the difference between two sig-
nals.

To Selection
(Alt/Opt-Shift-V)

Pastes audio from the clipboard only
into the selected space, regardless of
the copied audio's length. If the
copied audio is longer than the new
selection, the audio will be cropped
to fit. If the new selection is longer
than the copied audio, silence will be
inserted to fill the remaining space.

Deselect (Control/Command-D)
If audio is selected, deselects it and places the anchor sample at the start of the
selection.

Reselect (Esc)
Restores the last selection if you have no current selection.

Select All (Control/Command-Shift-D)
Selects the entire open file.

Invert Selection (Control/Command-Shift-I)
Selects everything that isn’t currently selected.

Invert Selection Frequencies (Control/Command-I)
Selects everything in the current time range that isn’t selected.  This is useful for
refining processing by first selecting what you don’t want to process, then
inverting the selection frequency.



Select Harmonics (Control/Command-Shift-H)
Refines the current selection to include more harmonics.  For this feature to
work well, try it with a simple selection that includes only the fundamental
harmonic of what you are trying to select.

You can also use the Magic Wand tool to automatically refine a selection to
include the appropriate harmonics.

Begin Selection at Playhead ( [ )
(during playback only)

If audio is currently selected, this will automatically adjust the selection to begin
at the current playback position.

End Selection at Playhead ( ] )
(during playback only)

Automatically create a selection between the current playhead postion and the
original anchor playhead position.

Delete Selection (Delete on a time selection)
Deletes the selected audio and closes the space with audio from either side of
the timeline.

Silence (Delete on a frequency, time-frequency, or freeform
selection)
Deletes selected audio and replaces it with silence.

Trim to Selection (Control/Command-T)
Deletes all audio except for the selected audio.

Find Similar Event (Control/Command-F)
The Find Similar Event tool lets you choose a selection in RX's Spectrogram
Display and automatically finds similar events before or after that event.



The following controls are available:

Similarity Lower values will find more events. The higher
the value, the more similar an event must be to
the original event for it to be detected.

Search Duration How many seconds along a file’s timeline the
Find Similar Event tool will browse searching
for events.

Number of Bands The number of frequency bands the tool uses to
find events. In general, more bands allows the
tool to be more precise in frequency, but less
precise in time.

Search using previous
undo level

Uses the audio under the selection from the pre-
vious undo level as the basis for comparison.  If
you are repairing a repeating sound with
Declick, enable this option, repair the event in
your selection, and then use Find Similar Event
to find the next similar problem.

Add Marker or Region (M)
This will create a new marker point at the current location of the cursor/playhead
or create a new region if any audio is selected.

Edit Cursor Mode
Changes the behavior of the editor cursor to select by time and/or frequency, or
to zoom. These modes can also be selected from the Cursor Mode buttons.

Select Time (T) Makes a time selection
Select Time/Freq (R) Makes a rectangular time-frequency selec-

tion
Select Freq (F) Makes a frequency selection for the dur-

ation of a file
Lasso (L) Selects everything in a freely defined area
Selection Brush (B) Selects everything in a predefined radius
Selection Wand (W) Intelligently selects material similar to



whatever is under your cursor (magic wand)
Zoom Time (Z) Zooms in time
Zoom Time/Freq (Shift-Z) Zooms in time and frequency
Zoom Freq (Alp/Opt-Z) Zooms in frequency
Grab Time (G) Grabs and drags the view in time
Grab Time/Freq (Shift-G) Grabs and drags the view in time and fre-

quency
Grab Freq (Alt/Opt-G) Grabs and drags the view in frequency

Preferences (Control/Command-,)
Shows the Preferences dialog.

Preferences
Audio

Display

Keyboard Shortcuts

Miscellaneous

Authorization & Updates

Plug-ins



Audio

Driver Type
Allows you to select a sound card driver model to use for playback and
recording.

Note: Some hardware devices monopolize the audio drivers when sending
audio clips to RX via RX Connect. If you are not able to hear the audio sent to
RX from your DAW via RX Connect, change the audio driver to RX Monitor in
the Driver type menu. See RX Monitor.

The rest of the dialog contains settings for your audio device and also includes
a test tone generator.

Input/Output Device
Choose the device/sound card you want RX to use for playback and recording.



Buffer Size
The total playback buffer size. In general, lowering these buffer sizes will
improve meter responsiveness and lower latency, but increase CPU needs.
Raising buffer sizes will lower CPU cost but increase latency. It's worth
exploring these ranges to find values that work best on your system.

Num Buffers
Number of playback sub-buffers. (MME Only.)

Channel Routing
For ASIO and CoreAudio drivers, click this button to choose which input and
output channels RX uses. Click the Channel Routing button to open the
Channel Routing dialog box.

Configure Driver
Launches the manufacturer’s driver configuration dialog.

Release when not in use
Auto-closes the audio device when playback in RX stops, freeing it for use in
other audio applications.  Disable this if playback from RX isn’t responsive
enough.

Test Tone
The test tone generator is useful for testing your speakers, audio hardware and
listening environment. Tones at set frequencies or at a custom frequency can be
used as test tones, as can white or pink noise. In addition, a Channel
Identification mode will identify left and right speakers. 

Enable
Starts playback of a test tone.

Type
Sets the type of test tone to play.



Volume
Sets the volume of the test tone.

Frequency
Sets the frequency of the test tone.

Channel Routing

The Channel Routing dialog is where you set input and output channels for your
hardware devices or ASIO drivers. If you have only a stereo pair of input and
stereo pair of output, RX defaults to those.

Note: If you are using ASIO drivers and want to share the drivers with another
software application, be sure to check the Release when not in use checkbox
on the Audio tab of the Preferences dialog.



Display

Show tooltips
When enabled, hovering over an RX feature with the mouse cursor will show a
short description of the feature.

Display cursor coordinates in status bar
When this is enabled, the time coordinate of the cursor is shown in the status
bar at the bottom of the RX main window. The amplitude of the audio at the
cursor position and the frequency at the cursor position is also shown.

Show analog waveform
When digital audio is played back, it is converted to analog. The peak values in
the analog waveform can be larger than the peaks in the digital waveform,
leading to clipping in the output of a digital-to-analog converter. When Show



analog waveform is enabled, RX will compute an analog waveform in the
background. Any peaks will be highlighted in red on top of the existing digital
waveform.

At very extreme zoom levels, RX always displays an analog waveform.

Offload waveform calculations
When this is enabled, RX's waveform display will be computed in the
background. This allows very large files to be loaded very quickly, but it slows
down RX's waveform displays.

Waveform interpolation order
If you zoom into the waveform so that individual samples become visible, RX
will display an upsampled analog waveform as well as the individual digital
samples. The interpolation order controls the quality of upsampling. Higher
values yield more accurate analog waveforms at the expense of CPU usage.

Brightness
Adjusts the general brightness of the RX interface, allowing you to make RX
more readable on your specific display.

Floating window opacity
Changes the opacity for RX's floating windows. This can be useful if you wish to
leave floating windows on top of the spectrogram and waveform without
completely obscuring the display.



Keyboard Shortcuts

While RX includes default keyboard shortcuts, you can also customize them to
your liking.

Presets
Save groups of key assignments with this tool.

Show commands containing
Lets you search by keyword for a command you want to assign to a keystroke.

Shortcuts for selected command
Shows if there are any keystrokes assigned to the command selected in the
above menu.



Remove
Removes the currently assigned keystroke from a command.

Press Shortcut Key
To assign a new keystroke to a command, select the command from the menu,
then click in this field and press a key or combination of keys.

Assign
Assigns the entered keystroke to the current command. The shortcut will only be
assigned to the current command if you press this button.

Shortcut key currently used by
Lists commands that the current keystroke is assigned to.

Note: On Windows systems, by default, 'Alt + a letter' will open the
corresponding menu for your currently open application. Alt + V for example will
open RX's View menu drop down. By default, none of RX's shortcuts should
conflict with these keyboard shortcuts, however if you wish to assign Alt + V to
another operation, it will take precedence over the View menu.



Miscellaneous

Session data folder
Allows you to choose a different folder to save RX's temporary session data.
These files are created to allow actions to be undone and sessions to be
recalled in RX.  Because these can be very large, it is best to set this to the drive
on your computer with the most free space.

Time scale frame rate
This sets the frame rate used to draw the time scale when RX is set to display
the time code (see View menu or right-click the time ruler to change this setting).
Choose from a list of standard frame rates or click in the combo box to define a
custom frame rate.



Default full-bandwidth paste mode
This controls RX's behavior when pasting a full-bandwidth audio selection.
Insert will move aside existing audio, Replace will overwrite existing audio, and
Mix will add to existing audio.

Default limited-bandwidth paste mode
Similar to the full-bandwidth paste mode, this controls RX's behavior when
pasting a limited-bandwidth audio selected.

Resume last editing session when app starts
On RX's start-up, the last audio file will be reloaded along with full history list of
any edits made.

Automatically open files ending with .L and .R as split ste-
reo
Mono audio files with (.L and .R) as well as (.1 and .2) extensions will be
opened as stereo files when this option is enabled.

Recall selections during undo/redo
When this is enabled, RX will recall the selection used for an item in the undo
history. When browsing the undo history, the selected region will be restored
along with the audio.

Sometimes it is useful to turn this off if you need to compare undo history items
and not break your current selection (like a useful loop).

Play only selected channels
If only a single channel of audio is selected and this option is enabled, all other
channels will be muted during playback.

Pre- and Post-Roll during preview (ms)
When Previewing audio processing in any module, the specified time amount
will be added to the beginning and end of the previewed selection in order to
provide contrast between unprocessed and preview-processed audio.



Selection Feathering (ms)
This control allows for crossfading of processed and unprocessed audio when
processing.  If you need to make more precise edits, set this to 0.

Authorization & Updates

Remove Authorization
Use the authorization menu to remove your current RX authorization, for
example if you have upgraded to RX Advanced and have already installed the
basic version. You may also need to unauthorize RX if you are using the RX
trial version and wish to try the RX Advanced trial version.

After removing your authorization, RX's authorization dialog will appear when
you restart the program. Now you can re-authorize the application using your
new serial number.



Check for Updates
Lets you change how frequently RX automatically checks for updates.  RX can
also check the iZotope download servers for program updates by clicking on the
Check Now button.

This option is initially set by the RX installer. If you don’t check for updates
when you install, RX will never check for updates again until you change this
setting.

Plug-Ins

Use these options tomanage your third party audio processing plug-ins.

VST / Audio Unit / DirectX plug-ins
These areas show what plug-ins are available for the specified format.  You can
also enable or disable every plug-in for the specified format using the
Enable/Disable button.



VST plug-in folders
Lets you add or remove custom VST plug-in folders. RX uses the system VST
plug-in folder by default.  If your VST plug-ins do not show up, try using this
option to add the directory where they are kept.

RX will also scan the first level of subfolders in this folder.  If some of your plug-
ins do not show up when you scan them, and you know they’re in a subfolder of
your plug-in folder, try moving them up one directory level.

Group plug-ins by name in plug-in menus
When enabled, the RX plug-in menu will group plug-ins by common first words,
usually the manufacturer’s name.

When disabled, the RX plug-in menu will appear as a single, alphabetically
sorted list.

Rescan
If RX detects that a plug-in is unstable, it will blacklist it and prevent it from being
opened.

This option allows you to clear RX’s blacklist of unsupported plug-ins and
rescan all installed plug-ins in case an RX update or an update from the plug-in
manufacturer resolves the issue.

View
Collapse / Expand Module Panel
Collapses the right side panel of RX into a row of icons. This can allow for a
much larger portion of the screen given to the overall Spectrogram/Waveform
display.





Collapsing themodule panel gives youmore room to edit and analyze your file.
You can quickly collapse themodule panel by clicking on the triangle at the top right of themodule

panel.

Time Format
RX's time scale and playhead location counter can be set to show different time
units. See more details in Time Scale Format section.

Snap (Control/Command-Shift-;)
This will cause selections to be snapped to the variables listed below in the
Snap To list.

n Markers
n Ruler (Coarse/Fine)
n Zero Crossings
n All
n None

Effect Overlays
This allows you to turn special display features for the Declip and Spectral
Repair modules on and off. For an overlay to be visible, you need to have the
option selected in the view menu, and the corresponding effect UI needs to be
open.

n Declipper Threshold—When the waveform is visible, the threshold set-
tings and controls appear as white lines within the display.  This display
can be used to adjust the declipper threshold settings.

Clip Gain
The Clip Gain envelope allows you to adjust the gain of your clip over time.

You can do the following with Clip Gain envelopes:



l Fade in/fade out
l Add nodes
l Adjust the gain of individual nodes
l Adjust the gain of an envelope selection

To use the Clip Gain envelope:

1. Select View > Clip Gain from the RX menu.
2. The Clip Gain envelope appears with two nodes, one at the beginning of the

clip, and one at the end of the clip.
3. Click and drag one of the two nodes to increase (by dragging the node up)

or decrease (by dragging the node down) the gain of the clip.



4. If necessary, add new nodes by pressing Cmd/Ctrl and clicking anywhere in
the editor view, or by clicking on the Clip Gain envelope itself.



Waveform Statistics
(Alt/Opt-D)

The Waveform Statistics window shows information about the waveform inside
your current selection.  This information can help you find and fix problems like
clipping more easily.  It is also useful for comparing two similar selections or
files.  RX treats your selection as a full bandwidth (time-only) selection when
calculating these statistics.

Waveform statistics automatically update to your current selection.  If no
selection is made, the statistics are collected from the entire audio file.

Using the cursor icon next to an item will move the playhead to the position in
the file where the level was detected.

True peak level
The highest peak level detected, including signal levels between digital
samples (called ISPs or Intersample Peaks).

True peak reflects the expected peak level of the analog waveform after digital-
to-analog conversion. In practice, it is calculated by oversampling of the digital



waveform according to BS.1770-3 standard. Different software may measure
true peak levels slightly differently, because the standard leaves some freedom
in choice of oversampling filters.

Sample peak level
The maximum level of digital samples in your selection.

Max. RMS level
The highest RMS level detected in the selection. 

RX measures RMS using 50-ms windows (more specifically, a Hann window
with a 100-ms period) and references levels using an AES-17 standard (“full-
scale sine wave = 0 dB RMS”). Other software may display RMS levels 3 dB
lower.

Min. RMS level
The lowest RMS level detected in the selection.

Total RMS level
The RMS level of the entire selection.

Possibly clipped samples
The number of samples where the true peak signal level exceeds 0 dBTP.

DC offset
The amount of DC offset, in percent of the full scale. Hover this value with your
cursor to see this level in decibels.

Max. momentary loudness and Max. short-term loudness
The maximum levels of momentary loudness and short-term loudness (as
defined by BS.1770). Momentary loudness is computed on a K-weighted audio
signal using 400-ms windows. Short-term loudness is using 3000-ms windows.



Integrated loudness
Displays the integrated loudness level (as defined by BS.1770-2). Settings in
the Loudness Match module may switch this field to BS.1770-1 standard.

Loudness range (LRA)
Displays the loudness range (as defined by BS.1770).  This value reflects the
dynamics of audio levels in the selection.

Spectrum Analyzer
The spectrum analyzer shows an important analytical view of audio. 

A spectrum analyzer uses a fast Fourier transform (FFT) to extract frequency
information from a waveform.  Depending on the size of the FFT, the signal
energy of thousands of frequency bands can be visually represented on a
graph.

The RX Spectrum Analyzer will show the momentary spectrum of audio around
the current playhead position, the average spectrum of a selected time and
frequency range, or the realtime spectrum of the audio at the output of RX’s
playback.



Blue (Anchor Sample)
The momentary spectrum of the audio around the playhead.

Yellow (Selection)

The time-averaged spectrum of the current selection. Use selection tools in the
spectrogram window to select a time and frequency range and the spectrum
analyzer will automatically zoom to follow the time and frequency range
selected.

Orange (Playback / Input)
The realtime spectrum of audio as it plays back.  When Input Monitoring is
enabled or RX is recording, the spectrum will show the input signal.

Peak Finding

The Peak Finding feature offers a precise view of peaking frequency information

The RX Spectrum Analyzer has a peak-finding feature the will automatically find
peaks in the spectrum data. If you hover your mouse cursor near a peak in the
spectrum, a readout will appear displaying the exact frequency of the peak, its



amplitude, and the closest musical note. This peak-finding readout can provide
much higher accuracy than simply inspecting the graph by zooming in on the
display and/or increasing the FFT size in the settings window.

The circle displays the exact amplitude and frequency of the spectral peak. It is
usually slightly above the spectrum, because each spectral peak consists of
several FFT bins, and their power is added together. This effect is known as
spectral smearing (or frequency smearing) and is controlled by the choice of a
weighting window.

Zooming and Scale Selection
Both the vertical (dB) axis and the horizontal (Frequency) axis can be zoomed
in and out with the mouse wheel while the cursor is over either axis. Once
zoomed in, click and drag on the rulers to pan the spectrum display left to right,
or up and down.

Double-clicking on the rulers will reset the zoom to the their default value.

Right-clicking on the horizontal and vertical ruler will also allow you to change
the displayed scale of each ruler respectively:

Frequency scales: Linear, Mel, Bark, Log, Extended Log

Magnitude scales: Decibel, 90 dB + Inf., 120 dB + Inf.

Spectrum Analyzer Settings

Analyzer settings can be shown or hidden with the wrench icon in the upper right corner of the
Analyzer window

FFT Size
Sets the FFT size for spectrogram calculation in samples. A greater FFT size
provides greater frequency resolution but requires a longer segment of the
audio signal to be analyzed.  A smaller FFT size provides better time resolution,
but individual frequency components in the signal will become less distinct.



Time Overlap
Sets the FFT window overlap for the spectrum analyzer in real-time playback
mode. Enhances time resolution but also affects the spectrum update rate
during playback and increases CPU consumption.

Decay
Sets the decay rate (or fall time) of the real-time spectrum.

Window
Sets the FFT weighting window, which addresses frequency smearing. 
Frequency smearing is the leakage of a signal from one FFT band into another.

Different FFT windows represent different mathematical interpretations of FFT
information.  They are different views of the same information.





A 1 kHz sine tone viewed through Bartlett, cos3, and Hamming analysis windows.
Bartlett and Hamming display significant leakage of the 1 kHz tone into side lobes, but the cos3

window does not.
They all display the same peak information for the 1 kHz tone.

Channel Mode
Controls how multiple channels of audio are displayed.

RX can display stereo spectra individually (Multichannel), display the maximum
of two spectra (Max), or display the spectrum of a signal downmixed to mono
(Average).

Reset
Resets spectrum analyzer to default settings.

Markers and Regions
(Alt-M)
Markers and regions will allow you to define and save particular points or
selections in time for your particular audio file. All markers and regions that are
created will be saved along with your audio file when exporting.



Adding Markers and Regions
You can add a marker or region at the current location of the playhead by
pressing the M key or selecting Add Marker or Region from the Editmenu.

Markers and regions can also be created from the Markers and Regions dialog.

Play Begins playback from the start point of your marker or
region.

Find Moves the playhead to the exact position of your marker, but
will not begin playback. For a region, Find will select the
audio in the region.

Add Creates a new marker point at the exact current position of
the playhead.

Remove selec-
ted

Deletes the desired marker or region. The checkboxes to the
left of your Marker list designate your selection.

Select all Selects all markers and regions.
Select none Deselects all markers and regions.
Import... Opens saved marker information from another file or RX ses-

sion.
Export... Saves markers and regions in a tab-delimited text file that

can be opened and used in another file or session of RX.



Spectrogram Settings
(Control/Command-Shift-,)

Spectrogram Type
RX offers some different methods for displaying time and frequency information
in the spectrogram. RX’s advanced spectrogram modes allow you to see
sharper time (horizontal) and frequency (vertical) resolution at the same time.
There is always a tradeoff of display quality versus processing time, so keep in
mind that some modes will take longer to draw on the screen than others.

n Regular STFT (short-time Fourier transform) — this refers to the method
that's used to transform the audio data into the spectrogram display. This
type of spectrogram is the most common one and can be found in other
editors. It has a fixed uniform time-frequency resolution. This is the
simplest and fastest drawing mode in RX.

n Auto-adjustable STFT— this mode automatically adjusts FFT size (i.e.
time and frequency resolution of a spectrogram) according to the zoom
level. For example, if you zoom in horizontally (time) you'll see that per-
cussive sounds and transients will be more clearly defined. When you
zoom in vertically (frequency), you'll see individual musical notes and fre-
quency events will appear more clearly defined.



n Multi-resolution— this mode calculates the spectrogram with better fre-
quency resolution at low frequencies and better time resolution at high
frequencies. This mimics psychoacoustic properties of our perception,
allowing the spectrogram display to show you the most important inform-
ation clearly.

n Adaptively sparse— this mode automatically varies the time and fre-
quency resolution of the spectrogram to achieve the best spectrogram
sharpness in every area of the time-frequency plane. This often lets you
see the most details for a thorough analysis, but it's the slowest mode to
calculate.

FFT size
FFT is a fast Fourier transform, a procedure for calculation of a signal frequency
spectrum. The greater the FFT size, the greater the frequency resolution, i.e.
notes and tonal events will be clearer at larger sizes. However, choosing a
larger number here will make time events less sharply defined because of the
way this type of processing is done. Choosing Auto-adjustable orMulti-
resolution modes allows you to get a good combination of frequency and time
resolution without having to change this setting as you work.

Enable reassignment
This control enables a special technique for spectrogram calculation that allows
very precise pitch tracking for any harmonic components of the signal. When
used together with Frequency overlap / Time overlap controls, this option can
provide virtually unlimited time and frequency resolution simultaneously for
signals consisting of tones.

Window
This control lets you choose different weighting functions (or windows) that are
used for the FFT analysis. Window functions control the amount of signal
leakage between frequency bins of the FFT. “Weak” windows, such as
Rectangular, allow a lot of leakage, which may blur your spectrogram vertically.
“Strong” windows, such as Kaiser or cos3, eliminate leakage at the expense of a
slight loss of frequency resolution.



Frequency scale
Using different frequency scales can help you see useful information more
easily. Different scales have different characteristics for displaying the vertical
(frequency) information in the spectrogram display.

n Linear— this simply shows frequencies spread out in a uniform way.
This is most useful when you want to analyze higher frequencies.

n Logarithmic— this scale puts more attention on lower frequencies.
n Mel— the Mel scale (derived from the word Melody) is a frequency
scale based on how humans perceive sound. This selection is one of
the more intuitive choices because it corresponds to how we hear dif-
ferences in pitch.

n Bark— the Bark scale is also based on how we perceive sound, and
corresponds to a series of critical bands.

Frequency overlap
(also known as zero padding factor)

Controls the amount of oversampling on the frequency scale of spectrogram.
When used together with the Reassignment option, it will increase the
resolution of the spectrogram vertically (by frequency).

Time overlap
This controls the time oversampling of the spectrogram. In most cases, overlap
of 4x or 8x is a good setting to start with. However, using higher overlap together
with the Reassignment option will increase the time resolution of a spectrogram,
letting you see transient events clearly. 

Color map
RX's spectrogram display allows you to choose between several different color
schemes. There is no right or wrong color setting to use and we recommend you
try them all. Sometimes certain color modes will make different types of noise
stand out more clearly. Experiment!



High-quality rendering
Accurate max-bilinear interpolation of the spectrogram (recommended). Turning
this control off makes spectrogram rendering slightly faster, but you'll lose some
detail and clarity in the spectrogram image.

Reduce quality above
RX's spectrogram uses very accurate rendering, letting you see audio problems,
such as clicks, even at low zoom levels. However, performing such rendering
for long files can be somewhat slow. When the length of the visible spectrogram
is above the specified number of seconds, the spectrogram calculation is
changed to a fast and less accurate preview mode. When you zoom in, the
spectrogram calculation becomes accurate again.

Cache size (MB)
Limits the amount of memory used by the spectrogram.

Process Menu
Reverse

Reverses the selected audio in time. Works only on rectangular selections,
does not work on free-form selections.

Silence

Replaces the selected audio signal with silence. Works on selections of
arbitrary shape.

Declip

Declick

Remove Hum

Denoise

Spectral Repair

Deconstruct



Dereverb

Leveler

EQMatch

Ambience Match

Time & Pitch

Loudness

Plug-in Hosting

Gain

EQ

Channel Operations

Resample

Dither

Transport
Input Monitor (Alt/Option-I)
Enables input monitoring.  When input monitoring is enabled, the input signal of
RX will be routed to the output signal of RX.

Arm for Recording / Record / Stop Recording (Alt/Option-
Space)
Runs the next possible step for recording.

If you have not opened a new file, Arm for Recording will open the New File
dialog for you.

Rewind (Return)
Sets the playhead to the beginning of the file.



Play / Stop (Space)
Starts or stops playback.

If Input Monitoring is enabled, starting playback will temporarily suspend Input
Monitoring.

Loop Playback (Control/Command-L)
Toggles playback looping.  If nothing in the file is selected, the end of the file
will loop back to the beginning.

Playhead Returns on Stop (Control/Command-R)
Toggles the behavior of the playhead on stop.

If this is enabled, the playhead will return to the anchor sample (the position
before playback began).  This is useful for comparing processing.

If this is disabled, the anchor sample will be set to the current playhead position. 
This is useful for moving through a file while listening for irregularities.

Follow Playhead (Control/Command-P)
Toggles whether or not the current view follows the playhead position during
playback.

In Page mode, the view will follow the playhead one view length at a time.  In
Continuous mode, the view is centered on the playhead as it moves across the
file.

Window
This menu displays a list of your currently open files.  Clicking on any of them
will bring you to that file.

Next File (Control-Tab)
Changes RX’s current file tab to the next file in the window order.



Previous File (Control-Shift-Tab)
Changes RX’s current file tab to the previous file in the window order.



iZotope RX End User License
Agreement
IZOTOPE, INC. SOFTWARE LICENSE AGREEMENT

THIS IS A LEGAL AGREEMENT BETWEEN YOU AND IZOTOPE, INC.
(“iZotope”). READ THIS AGREEMENT CAREFULLY BEFORE YOU CLICK
ON THE “I ACCEPT” OPTION BELOW. BY CLICKING ON THE “I ACCEPT”
OPTION, YOU AGREE THAT YOU HAVE READ AND UNDERSTAND THIS
AGREEMENT AND WILL BE BOUND BY ITS TERMS AND CONDITIONS.

LICENSE. Subject to all the terms and conditions of this Agreement, you (a
natural person) may use the version of the iZotope software product
accompanying this Agreement, and any user documentation provided, whether
in printed, “online” or electronic form (collectively, the “Software”), either on a
stand-alone computer or on a network, on any one computer at any one time. If
more than one user will be using the Software at any one time, you must obtain
from iZotope an additional license for each additional concurrent user of the
Software. The Software is “in use” on a computer when loaded into memory
(RAM). You may make one copy of the Software solely for backup or archival
purposes if all copyright and other notices are reproduced on that copy, or you
may copy the Software to a single hard disk provided you keep the original
solely for backup or archival purposes. If the Software is an upgrade, you must
have a license for the product from which it is upgraded. If you receive the
Software in more than one media, that does not affect the number of licenses
you are receiving or any other term of this Agreement.

OWNERSHIP. The copyrights, patents, trade secrets, trademarks, and all other
intellectual property rights in the Software and documentation (including any
images, photographs, animations, video, audio, music and text incorporated in
them) are owned by iZotope or its suppliers and are protected by the copyright,
patent and other laws of the United States and other countries and by
international treaty provisions. iZotope retains all rights not expressly granted in
this Agreement.

OTHER RESTRICTIONS. You may not modify, adapt, decompile, disassemble
or otherwise reverse engineer the Software, except to the extent this restriction
is expressly prohibited by applicable law. You may not loan, rent, lease, or
license the Software, but you may permanently transfer your rights under this



Agreement provided you transfer this Agreement, the Software, and all
accompanying printed materials and retain no copies, and the recipient agrees
to the terms of this Agreement. Any such transfer must include the most recent
update and all prior versions.

LIMITED WARRANTY. iZotope warrants that, for a period of thirty (30) days
from your date of receipt, the Software will substantially conform to the
applicable user documentation provided with the Software. Any implied
warranties which may exist despite the disclaimer herein will be limited to thirty
(30) days. This Limited Warranty is void if you buy from an unauthorized
reseller, you violate the terms of this Agreement, or if the failure of the Software
is due to accident, abuse or misapplication. Some states/jurisdictions do not
allow limitations on duration of an implied warranty, so this limitation may not
apply to you.

YOUR REMEDIES. iZotope's sole obligation and your exclusive remedy for any
breach of warranty will be, at iZotope's sole option, either the return of the
purchase price you paid or, if you return the Software, together with all media
and documentation and a copy of your receipt, to the location where you
obtained it during the warranty period, the repair or replacement of the Software,
media and documentation. Outside the United States, neither these remedies
nor any support services are available without proof of purchase from an
authorized non-U.S. source.

SUPPORT: Subject to the limited warranty stated above, and further subject to
you not being in violation of any term of this Agreement, iZotope will provide
email support for the Software to the original purchaser, for a period of 12
months from the original purchase date.

REGISTRATION INFORMATION. When you activate the Software, iZotope
may collect your name and email address and other contact information you
choose to provide. IZotope may use this information to contact you regarding
upgrades and new products, and also to gather statistical data that does not
identify individual users. iZotope does not collect or retain any financial
information (such as credit card information).

USAGE INFORMATION. When you use the Software, iZotope may collect
certain information about your computer and your interaction with the Software
via the internet (“Usage Information”). Usage Information is information on how
you interact with the Software, and is then utilized by iZotope for statistical
analysis for improving the Software, and to provide you with a more relevant



user experience. No direct personal information or audio files/samples are
collected as part of this Usage Information. Usage Information is generally
collected in the aggregate form, without identifying any user individually,
although IP addresses, computer and session ids in relation to purchases and
downloads/installations of the Software may be tracked as part of iZotope's
customer order review, statistical analysis, and fraud and piracy prevention
efforts. This Usage Information may be sent to an iZotope web or third party
cloud server for storage or further processing by iZotope and/or its partners,
subsidiaries or affiliates, including, but not limited to, Trackerbird, Inc. The
Software includes an opt-out provision if you do not wish to provide iZotope with
such Usage Information.

DISCLAIMER. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE
LAW, IZOTOPE DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. IZOTOPE DOES NOT WARRANT THAT THE
SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE
SOFTWARE WILL OPERATE UNINTERRUPTED OR ERROR-FREE. THE
WARRANTY AND REMEDIES SET FORTH HEREIN ARE EXCLUSIVE AND
IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. The
Limited Warranty set forth herein gives you specific legal rights, and you may
have others under applicable law, which may vary depending on your location.
No dealer, distributor, agent or employee of iZotope is authorized to change or
add to the warranty and remedies set forth herein. Any other software furnished
with or accompanying the Software is not warranted by iZotope.

LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, IZOTOPE WILL HAVE NO LIABILITY FOR ANY
DAMAGES WHATSOEVER ARISING OUT OF THE USE OF OR INABILITY
TO USE THE SOFTWARE (INCLUDING, WITHOUT LIMITATION, DAMAGES
OR COSTS FOR LOSS OF PROFITS, BUSINESS, GOODWILL, DATA OR
OTHER ASSETS, OR COMPUTER PROGRAMS) EVEN IF IZOTOPE HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT
WILL IZOTOPE BE LIABLE FOR ANY AMOUNTS EXCEEDING THE
AMOUNTS RECEIVED FROM YOU FOR YOUR LICENSE OF THE
SOFTWARE. Some jurisdictions do not allow exclusion or limitation of liability
for consequential or incidental damages, so this limitation may not apply to you.



TERMINATION. The Agreement will terminate automatically if you fail to comply
with any of its terms. On termination, you must immediately cease using and
destroy all copies of the Software.

LICENSES TO U.S. GOVERNMENT. This paragraph applies to all acquisitions
of the Software by or for the federal government, or by any prime contractor or
subcontractor (at any tier) under any contract, grant, cooperative agreement or
other activity with the United States government (collectively, the “Government”).
By clicking “I ACCEPT” below, you are agreeing on behalf of the Government
that the Software and any documentation related thereto are respectively
“commercial computer software” and “commercial computer software
documentation” within the meaning of the acquisition regulation(s) applicable to
this procurement. These terms and conditions alone will govern the
Government’s use of the Software and will supersede any conflicting
contractual terms or conditions. If the license granted by these terms and
conditions fails to meet the Government’s needs or is inconsistent in any
respect with Federal law, the Government must return the Software unused to
iZotope. Contractor/Manufacturer is iZotope, Inc., 700 Technology Square, Suite
400, Cambridge, MA 02139.

GENERAL. The export of the Software from the United States and re-export
from any other country is governed by the U.S. Department of Commerce under
the export control laws and regulations of the United States and by any
applicable law of such other country, and the Software may not be exported or
re-exported in violation of any such laws or regulations. This Agreement is the
complete and exclusive statement of the agreement between you and iZotope
and supersedes any proposal or prior agreement, oral or written, and any other
communications relating to the subject matter of this Agreement. This
Agreement will be governed by and interpreted under the laws of the
Commonwealth of Massachusetts, United States of America, without regard to
conflicts of law provisions; however, if you acquired the Software outside the
United States, local law may override this sentence and apply instead. The
application of the United Nations Convention of Contracts for the International
Sale of Goods is expressly excluded. This Agreement is in the English
language only, which language will be controlling in all respects, and all
versions of this Agreement in any other language will be for accommodation
only.



Should you have any questions about this Agreement or iZotope's software use
policies, or if you desire to contact iZotope for any other reason, in the U.S.,
please email sales@izotope.com; outside the U.S., please contact the iZotope
representative or affiliate serving your country or, if you are unsure whom to
contact, iZotope at the above location.

Please indicate that you understand and accept these terms by clicking the
“Accept” option. If you do not accept these terms, installation will terminate.



License Information

FLAC
What we're using: libFLAC and libFLAC++

Text below is from COPYING.Xiph in flac-1.3.0:

Copyright (C) 2000-2009 Josh Coalson

Copyright (C) 2011-2013 Xiph.Org Foundation

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

l Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

l Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

l Neither the name of the Xiph.org Foundation nor the names of its con-
tributors may be used to endorse or promote products derived from this soft-
ware without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.



Ogg Vorbis
What we're using: libogg and libvorbis

Text below is from COPYING in libogg-1.3.1:

Copyright (c) 2002, Xiph.org Foundation

Redistribution and use in source and binary forms, with or without

modification, are permitted provided that the following conditions

are met:

l Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.

l Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

l Neither the name of the Xiph.org Foundation nor the names of its con-
tributors may be used to endorse or promote products derived from this soft-
ware without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.

Text below is from COPYING in libvorbis-1.3.3:

Copyright (c) 2002-2008 Xiph.org Foundation



Redistribution and use in source and binary forms, with or withoutmodification,
are permitted provided that the following conditionsare met:

l Redistributions of source code must retain the above copyrightnotice, this
list of conditions and the following disclaimer.

l Redistributions in binary form must reproduce the above copyright notice,
this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution.

l Neither the name of the Xiph.org Foundation nor the names of its con-
tributors may be used to endorse or promote products derived from this soft-
ware without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.



Index: Audio – Decrackle

A

Audio

identifying problems
with 28

Authorization 8

Autosave 25

B

Batch Processing 43

job-based 43

Broadband noise

reapairing 38

Buzz

repairing 34

C

Channel operations 149

Channel Operations

Azimuth 152

extract center 153

mixing 149

Phase 150

Clicks

finding 85

repairing 32

Clipping

repairing 31

Compare 64

Connect plug-in 66

Crackle

repairing 33

Crackles

finding 85

Current Time Indicator 15

Customer Support 8

D

Declick 83

controls 87

Declip 77

controls 79

Deconstruct 121

controls 123

Decrackle 83
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Index: Denoise – High frequency buzz

Denoise 96

controls 102, 111

Dereverb 123

controls 126

Dialogue Denoiser 111

automation 114

Display

piano roll 22

spectrogram 17

waveform 17

Distortion

repairing 31

Dither 157

controls 158

Dropouts

repairing 40

E

Edit menu 171

EQ controls 146-147

Export History 25

F

File

opening 12

playback 12

File menu 160

Close 169

Export 164

Export History 169

New 161

Open 162

Save 169

FLAC

license information 213

Frequency ruler 21

G

Gain controls 145

Gaps

repairing 40

H

High frequency buzz

repairing 36
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Index: Hiss – Plug-in

Hiss

repairing 38

Hum

repairing 34

I

iLok Support 8

Input

gain control 72

metering 72

Input Monitoring 15

Interface 11

Interference

repairing 36

Intermittent noises

repairing 39

Interpolate controls 89

K

Keyboard shortcuts 45

L

License Information 213

Loop 15

M

Menu 160

Time Format Ruler 22

Mouth noise

repairing 33

O

Ogg Vorbis

license information 213

Output

gain control 72

metering 72

Overview 10

P

Pitch Contour 140

controls 140

Play 15
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Playhead 14

Plug-in

history 72
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Index: Plug-in history – RX Module

Plug-in history

clearing 72

Plug-in hosting 144

Pops

repairing 32

Preferences

keyboard 45

Misc tab 25

Preferences menu

Audio 176

Authorization &
Updates 185

Display 179

Keyboard shortcuts 181

Miscellaneous 183

Plug-ins 186

Preset Keyboard
shortcuts 60

Presets 70

Preview 62

R

Record 15

Recording

troubleshooting 16

Recording Audio 16

Remove Hum 89

controls 93

Resample 154

controls 155

Reverb

removing 41

Rewind 15
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General options 73

I/O options 73

RX 4 Advanced 6

RX Connect

no sound when using 68

using RX Monitor with 68

RX Documents

backing up with 27

RX Module

controls 59
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Index: RX Modules – Tools

RX Modules 58

working with 59

RX Monitor 68

RX Plug-ins 58

working with 65

S

Selection Modifiers 53

Channel Selection 55

Find Similar Events 56

Grab 55

Seek 55

Subtract 53

Selection Ranges 24

Selection Tools 50

Selections

working with 50

Short impulse noises

repairing 32

Spectral amplitude ruler 21

Spectral repair 115

controls 119

Spectrogram

changing colors of 20

color map 22

vertical rulers 20

Spectrum Analyzer 28, 194

controls 196

T

Time & Pitch 134

controls 136

Time Format Ruler menu 22

Tools

Brush Selection 51

Frequency Selection 51

Grab and Drag 52

Invert Frequency Selec-
tion 52

Invert Selection 52

Lasso Selection 51

Magic Wand Selection 52

Select Harmonics 52

Time-Frequency Selec-
tion 51
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Index: Transport Controls – Zooming

Time Selection 51

Zoom Selection 52

Transport Controls 14

Transport menu 205

U

Undo History 25

Utility modules 143

gain 145

V

View menu 187

Markers and Regions 199

Spectrogram
Settings 201

Waveform Statistics 192

View Ranges 24

W

Waveform

vertical rulers 20

Waveform Overview 19

Waveform Statistics 28

Window menu 206

Z

Zoom Sliders 23

Zoom Tools 23

Zooming 23
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